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Preface

As part of an effort to improve and enhance the performance and capabilities 
of its product lines, Sun periodically releases revisions of its hardware and 
software. Therefore, some functions described in this document may not be 
supported by all versions of the software or hardware currently in use. For 
the most up-to-date information on product features, refer to your product 
release notes.

If a product does not function properly or does not function as described in 
this document, please contact your Sun representative.

Audience
This document is part of the Sun StorageTek EBS documentation set, 
and is intended for use by system administrators during the 
installation and setup of Sun StorageTek EBS software. 

Related documentation
For more information about  Sun StorageTek EBS  software, refer to 
this documentation:

◆ Sun StorageTek Enterprise Backup Software, Release 7.4, 
Administration Guide

◆ Sun StorageTek Enterprise Backup Software, Release 7.4, Release Notes

◆ EMC Information Protection Software Compatibility Guide
Preface 7
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Conventions used in this guide
Sun uses the following conventions for notes, cautions, and 
important notices.

Note: A note presents information that is important, but not hazard-related.

CAUTION!
A caution contains information essential to avoid data loss or 
damage to the system or equipment. 

IMPORTANT!
An important notice contains information essential to operation of 
the software. 

Typographical conventions
Sun uses the following style conventions in this guide:

Normal Used in running (nonprocedural) text for:
• Names of interface elements (such as names of windows, 

dialog boxes, buttons, fields, and menus)
• Names of resources, attributes, pools, Boolean expressions, 

buttons, DQL statements, keywords, clauses, environment 
variables, filenames, functions, utilities

• URLs, pathnames, filenames, directory names, computer 
names, links, groups, service keys, file systems, notifications

Bold: Used in running (nonprocedural) text for:
• Names of commands, daemons, options, programs, 

processes, services, applications, utilities, kernels, 
notifications, system call, man pages

Used in procedures for:
• Names of interface elements (such as names of windows, 

dialog boxes, buttons, fields, and menus)
• What user specifically selects, clicks, presses, or types

Italic: Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis (for example a new term)
• Variables

Courier: Used for:
• System output, such as an error message or script 
• URLs, complete paths, filenames, prompts, and syntax when 

shown outside of running text 
Sun StorageTek Enterprise Backup Software Release 7.4 Installation Guide



Accessing Sun Documentation Online
The docs.sun.comTM web site enables you to access a select group of 
Sun technical documentation on the Web. You can browse the 
docs.sun.com archive or search for a specific book title or subject at:

http://docs.sun.com

Ordering Sun Documentation
Sun StorEdge EBS documentation is orderable from Sun 
Microsystems, Inc. price book. Contact your Sun representative for 
details.

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your 
comments and suggestions. You can email your comments to Sun at 
docfeedback@sun.com

Please include the part number (819-0287-10) of your document in the 
subject line of your email.

Courier bold: Used for:
• Specific user input (such as commands) 

Courier italic: Used in procedures for:
• Variables on command line
• User input variables 

< > Angle brackets enclose parameter or variable values supplied by 
the user

[ ] Square brackets enclose optional values

| Vertical bar indicates alternate selections - the bar means “or”

{ } Braces indicate content that you must specify (that is, x or y or z)

... Ellipses indicate nonessential information omitted from the 
example
Preface 9
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Introduction
About the Sun StorageTek EBS product
The  Sun StorageTek Enterprise Backup Software product is a suite of 
storage management software that provides backup, recovery, and 
other services to computers with a wide variety of operating systems 
and data types. Sun StorageTek EBS products for different operating 
systems are interoperable. This provides the flexibility to design a 
storage management system that works best with the current 
computing environment.

The Sun StorageTek EBS software is distributed in  a media kit that 
contains the software and electronic documentation for several 
related Sun StorageTek EBS products.The Sun StorageTek EBS 
product has five major components: 

◆ Sun StorageTek EBS client

◆ Sun StorageTek EBS storage node

◆ Sun StorageTek EBS server

◆ Sun StorageTek EBS Management Console

◆ NetWorker License Manager

Sun StorageTek EBS client
The Sun StorageTek EBS client software communicates with the Sun 
StorageTek EBS server and provides recover and ad hoc (manual) 
backup functionality. The Sun StorageTek EBS client software is 
installed on all computers that are backed up to the Sun StorageTek 
EBS server. 

Sun StorageTek EBS clients do not have to be running the same 
operating system as the Sun StorageTek EBS server. However, to back 
up clients that are running other operating systems, the Sun 
StorageTek EBS server must have a  ClientPak® enabler for that client. 
For example, in order for the NetWorkerSun StorageTek EBS server 
for IRIX to back up Sun StorageTek EBS clients that are running 
another operating system, a separate ClientPak enabler must be 
purchased and entered for that operating system.
Sun StorageTek Enterprise Backup Software Release 7.4 Installation Guide
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Sun StorageTek EBS storage node
Data can be backed up directly to devices that are attached to a Sun 
StorageTek EBS server, or to a Sun StorageTek EBS storage node. A 
storage node controls storage devices such as tape drivers, 
autochangers, and silos. 

Storage nodes depend on the Sun StorageTek EBS server for these 
functions:

◆ Control over which clients use the storage node’s devices for 
backups

◆ License management

◆ Management of the client file indexes that track each client’s data

◆ Management of the media database that tracks the data on each 
volume

Sun StorageTek EBS storage nodes and the Sun StorageTek EBS server 
can use different operating systems. To use a Sun StorageTek EBS 
storage node on a Linux operating system with a Sun StorageTek EBS 
server that is running another operating system, the storage node’s 
enabler on the server must be of the same edition as the base enabler 
for the Sun StorageTek EBS server.

Sun StorageTek EBS server
The Sun StorageTek EBS server software provides control and 
scheduling for Sun StorageTek EBS operations. It enables you to:

◆ Enter the enabler licenses for the Sun StorageTek EBS server and 
all the functions the Sun StorageTek EBS server controls, such as 
autochanger modules, additional client connections, and 
ClientPak licenses.

◆ Define the clients, devices, and media that the Sun StorageTek 
EBS server controls.

◆ Define the schedules for backups and other operations.

◆ Monitor the results of backups and other operations.

◆ Manage the client file indexes that track each client’s data.

◆ Manage the media database that tracks the data contained on 
each volume.
About the Sun StorageTek EBS product 13
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Sun StorageTek EBS Management Console
All Sun StorageTek EBS servers and clients are managed from the Sun 
StorageTek EBS Management Console. The Console replaces the Sun 
StorageTek EBS Administration program (nwadmin) which is no 
longer available.

To administer Sun StorageTek EBS servers, the Console must be:

◆ Installed on an AIX, HP-UX, Linux, Solaris, or Microsoft 
Windows host.

◆ Accessed through a graphical user interface on the host with a 
web-enabled browser that has the specified version of Java 
Runtime configured.

The Console provides reporting, managing, and monitoring 
capabilities for all Sun StorageTek EBS servers and clients. Multiple 
users can access the Console server concurrently from different 
browser sessions. A computer that hosts the web-enabled browser 
can also be a Sun StorageTek EBS client, server, or storage node.

You must install the Console software on one computer in your 
datazone to manage and monitor the Sun StorageTek EBS server. 
Only one installation of the Console is required to manage multiple 
Sun StorageTek EBS servers and to take full advantage of the 
Console’s consolidated reporting feature.

NetWorker License Manager
The NetWorker License Manager provides a central location for 
managing the licenses of all the Sun StorageTek EBS clients and 
servers. Instead of managing licenses separately, all Sun StorageTek 
EBS licenses can be maintained from a single computer. Installation of 
the NetWorker License Manager software is an option when 
installing the Sun StorageTek EBS software.

The NetWorker License Manager Installation and Administration 
Guide and the NetWorker License Manager Release Notes provides 
information about the NetWorker License Manager.

Supported devices
Sun StorageTek EBS software supports a variety of media types and 
devices, either stand-alone or in an autochanger or silo tape library. 
Sun StorageTek Enterprise Backup Software Release 7.4 Installation Guide



Introduction
Devices can be attached to a Sun StorageTek EBS server or designated 
storage node. 

The term autochanger refers to a variety of backup devices: 

◆ Autoloader 

◆ Carousel

◆ Datawheel

◆ Jukebox

◆ Library

◆ Near-line storage

The EMC Information Protection Software Compatibility Guide 
provides the latest list of supported devices. 

Enabler codes
Enabler codes (licenses), which activate the functionality of Sun 
StorageTek EBS software are sold separately. The section “Licensing 
and Enabling the Software” on page 95 provides information.
Enabler codes 15
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Software Requirements
General requirements

Note: Sun StorageTek EBS software does not support locales (defined by the 
operating system) or code sets that remap characters that have special 
meaning for file systems. Depending on the file system, these special 
characters may include the slash (/), the backslash (\), the colon (:), or the 
period(.). For example, De_DE.646 is an unsupported locale. The  provides 
the latest informationSun StorageTek Enterprise Backup Software, 
Administration Guide.

Language Support
To view non-English data, ensure that the operating system is 
installed with the required language support software and that the 
corresponding language locale is enabled.

TCP/IP requirements
These are the TCP/IP network communication requirements: 

◆ All Sun StorageTek EBS server, storage nodes, and client host 
computers must have TCP/IP installed, configured, and 
networked.

◆ The Sun StorageTek EBS server hostname must be added to the 
Domain Name System (DNS) database for the network, or to the 
local hosts file located in:

/etc/hosts

Note: If DNS is used, reverse lookup must be correctly configured.

◆ If the Sun StorageTek EBS server host is a Dynamic Host 
Configuration Protocol (DHCP) client, it must have a reserved 
address.

◆ The TCP/IP hostname must be identical to the computer name. 
Do not include an underscore character (_) in the computer name.

◆ If DHCP with dynamic addresses is used, DHCP must be 
synchronized with DNS.

◆ The Sun StorageTek EBS server’s TCP/IP hostname and 
computer name must be the same.
Sun StorageTek Enterprise Backup Software Release 7.4 Installation Guide



Software Requirements
Client software requirements
For Sun StorageTek EBS clients on the same hardware platform as the 
Sun StorageTek EBS server, use the same installation files to install 
the clients and server. For Sun StorageTek EBS clients on other 
hardware platforms, you must purchase a separate ClientPak license. 

The client software can be installed either on a remote network file 
system-mounted directory or a local drive.

The EMC Information Protection Software Compatibility Guide 
provides a list of supported operating systems.
Client software requirements 19
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Software Requirements
Storage node requirements
To install the Sun StorageTek EBS storage node software, the 
following requirements must be met:

◆ At least one supported storage device must be attached and 
installed. The device can either be a stand-alone device, 
autochanger, or silo tape library. The EMC Information Protection 
Software Compatibility Guide provides a list of supported 
devices.

◆ Sun StorageTek EBS software also supports the use of file type 
and advanced file type devices. The Sun StorageTek Enterprise 
Backup Software, Administration Guide provides more details.

The EMC Information Protection Software Compatibility Guide 
provides a list of supported operating systems.

Storage device requirements
Install one or more storage devices installing the Sun StorageTek EBS 
server software. Ensure that you install the SCSI adapter, cabling, and 
termination. The Sun StorageTek EBS installation program assumes 
that the storage devices have been properly installed and configured, 
and that the operating system recognizes the devices. The EMC 
Information Protection Software Compatibility Guide provides a list 
of the supported devices.

Note: You must use a nonrewinding device for Sun StorageTek EBS backups. 
Sun StorageTek EBS software writes a filemark on the volume at the end of 
each backup. When the next backup occurs, Sun StorageTek EBS software 
appends data to the volume based on the position of the filemark. If a device 
automatically rewinds the tape, the filemark position is lost and the next 
backup overwrites existing data. In that case, you would not be able to 
recover the previous backup data.

Server software requirements
This section describes the default location and space requirements for 
Sun StorageTek EBS software.
Sun StorageTek Enterprise Backup Software Release 7.4 Installation Guide



Software Requirements
Default location and space requirements
These pathnames and directories are required for installation: 

◆ The directory on the server is large enough for the Sun StorageTek 
EBS resources, client, server indexes, and media database (usually 
/nsr).

◆ The system pathname of at least one storage device for use by the 
Sun StorageTek EBS server to back up and recover files.

◆ If a tape device is being used to back up data, use a valid 
pathname for that device. The tape device must be nonrewinding. 

◆ A directory for the PDF documentation files and for Adobe 
Acrobat Reader (if it is not already installed).

If the default locations and space requirements are accepted during 
installation, the installation script creates the directories listed, see 
Table 1 on page 21  for details. 

Console
This section lists the Console server, client and database software 
requirements.

Table 1 Solaris location and space requirements

Sun StorageTek EBS files Location Space required

Client files /usr/bin
/usr/lib/nsr
/usr/sbin

110 MB

Console and Client files /opt/lgtonmc/bin/nmc_config.sh 270 MB

Storage node /usr/sbin
/usr/lib/nsr
/usr/kernel/drv

92 MB

Server /usr/lib/nsr
/usr/sbin

61 MB

Client file index,media database /nsr varies

NetWorker License Manager /usr/sbin 3.7 MB
Console 21
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Software Requirements
Console server
The general requirements for installing the Console server include 
the following:

◆ An installed and licensed network of Sun StorageTek EBS servers, 
clients, and storage nodes. The NetWorker License Manager 
software is optional.

◆ A Java Runtime Environment (JRE), which is required in order to:

• Support the command line reporting feature.

• Download the Console client and display the user interface.

Note: You must install the Console server software on one computer in your 
datazone to manage the Sun StorageTek EBS server. Only one installation of 
the Sun StorageTek EBS Console server is required to manage multiple Sun 
StorageTek EBS servers.

System requirements

Table 2 on page 22 lists the system requirements for the Console 
server and database.

Table 2 Console server and database requirements

System features Requirement

Processor and RAM Minimum: 500 MHz with 128 MB of RAM; 512 MB to run reports.
As the number of Sun StorageTek EBS servers being monitored 
increases, increase the computer’s capabilities.
• For 50 servers: Dual 500 MHz with no less than 192 MB
• For 100 servers: Dual 800 MHz with no less than 256 MB
• For 200 servers: Dual 1.3 GHz with no less than 512 MB

Operating system Solaris 8, 9, 10

Software The Sun StorageTek EBS client, release 7.4 or later software must 
already be installed and running.

Java Runtime 
Environment

JRE 1.5_11. This is required to run the command line reporting feature.

Browsers • Netscape Communicator 8, on the supported Solaris platforms.
• Mozilla 1.7 on the supported Solaris platforms.

Available disk space • 350 MB + x, where: x is a buffer of disk space for the Console 
database.
Sun StorageTek Enterprise Backup Software Release 7.4 Installation Guide



Software Requirements
Console database
This section provides information on estimating the size and space 
requirements for the Console database.

Formula for estimating the size of the Console database
The Console server collects data from the Sun StorageTek EBS servers 
in the enterprise, and stores the data in its local Console database. By 
default, the database is installed on the local file system that can 
provide the most available space. Console integrates and processes 
this information to produce reports that facilitate trend analysis, 
capacity planning, and problem detection. The Sun StorageTek 
Enterprise Backup Software, Administration Guide provides 
information about reports.

To store the collected data, allocate sufficient disk space for the 
Console database. Several factors affect the amount of disk space 
required:

◆ The number of Sun StorageTek EBS servers monitored for the 
reports

◆ The number of savegroups run by each of those servers

◆ The frequency with which savegroups are run

◆ The length of time report data is saved (data retention policies)

Note: Since the amount of required disk space is directly related to the 
amount of historical data stored, the requirements can vary greatly, on 
average between 0.5 GB and several GB. Allow for this when planning 
hardware requirements.

Formula for estimating the space required for the Console 
database information
Use these formulas to estimate the space needed for different types of 
data and to estimate the total space required.

Save set media database

To estimate the space needed for the save set media database, 
multiply the weekly amount of save sets by the number of:

◆ Sun StorageTek EBS servers monitored by the Console

◆ Weeks in the Save Set Output policy
Console 23
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Software Requirements
The result indicates the length of time that a save set took to run 
successfully. The results also identify the number of files that were 
backed up, and how much data was saved during the operation.

Save set output

To estimate the space needed for the save set media database, 
multiply the weekly amount of output messages by the number of:

◆ Sun StorageTek EBS servers monitored by the Console

◆ Save Set Output Retention policy

The result indicates how many groups and save sets were attempted 
and their success or failure.

Savegroup completion data

To estimate the space needed for the save set media database, 
multiply the weekly amount of savegroups by the number of:

◆ Sun StorageTek EBS servers monitored by the Console

◆ Weeks in the Completion Data Retention policy

The result can be used to troubleshoot backup problems

Console client
Although the Console client does not need to be installed separately, 
the JRE which includes Java Web Start must be installed in order to 
download and run the program properly. When connecting to the 
Console server for the first time, there is a prompt to download the 
JRE and the Console client application. 

Table 3 on page 24 lists the system requirements for installing the 
Console client.

Table 3 Console client system requirements (1 of 2)

System features Requirement

Operating system • Solaris 8, 9, 10

Java Runtime Environment • JRE version 1.5_11

Browsers • Netscape Communicator 8, on the supported Solaris 
platforms.

• Mozilla 1.7 on the supported Solaris platforms.
Sun StorageTek Enterprise Backup Software Release 7.4 Installation Guide



Software Requirements
Using international fonts in UNIX non-US locale environments
The Console software can run (in English mode) on localized 
operating systems. It supports retrieval of double-byte characters 
from Sun StorageTek EBS data. If the appropriate non-English font is 
not available on the Console client, the retrieved data appears as 
illegible.

To use or view data from a localized, non-English Sun StorageTek 
EBS server:

1. Ensure that the appropriate language support package for Sun 
StorageTek EBS software has been installed.

2. Ensure that the appropriate font is available to the Console client.

Note: If the required font is not installed on the system, obtain it from the 
operating system vendor and install it on the system.

3. From the Console menu, select View>Fonts and perform one of 
these tasks: 

• Change the language locale to match that of the localized Sun 
StorageTek EBS language locale.

• Choose a language font that is already loaded in the operating 
system and which matches the location of the localized Sun 
StorageTek EBS language locale. 

Changing the language locale to match that of non-localized Sun 
StorageTek EBS data

There are two ways to change the language locale to match that of the 
localized Sun StorageTek EBS language locale. Choose one of the 
following:

Available disk space • Console client: 10 MB
• JRE with Web Start: 55 MB

RAM  A minimum of 512 MB to run reports.

Graphics card Must support the display of the following:
• At least 16-bit color (at least 65,000 colors)
• Screen resolution of at least 1024 x 768

Table 3 Console client system requirements (2 of 2)

System features Requirement
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◆ Before you log in to the host system:

a. Select Options on the Login dialog box. 

b. Select Options>Language.

c. Select a locale from one of three alphabetical lists.

◆ After you log in to the host system:

a. Type the setenv command to change the locale.

b. Depending on the language, select one of these:

– To match the French Sun StorageTek EBS locale, type:
setenv LANG fr

setenv LC_ALL fr

– To match the Japanese Sun StorageTek EBS locale, type:
setenv LANG ja

setenv LC_ALL ja

– To match the Simplified Chinese Sun StorageTek EBS 
locale, type:
setenv LANG zh

setenv LC_ALL zh

Changing the language font to view localized Sun StorageTek 
EBS data
Instead of changing the language locale, you can change the Console 
font, so that localized Sun StorageTek EBS data can be viewed from 
the Console software. The appropriate font must be loaded in the 
operating system of the Console server and client.

To load a font:

1. To select a language font, select Console>View>Font. The 
Change Font dialog appears.

2. Select the appropriate font and font size, if the default size is 
inappropriate and click OK.

Using a non-US locale
When using Console software in a non-US environment, support for 
the language locale and various language character sets is derived 
from the host operating system. In order to display non-English 
characters, the host operating system must have installed a font (or 
fonts) that supports those characters.
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The Console client, rather than the Console server, must have the 
appropriate language character sets supported in the client operating 
system. By default, Console software uses a non-UNICODE font that 
supports US English. 

If the font is loaded in the operating system, a language locale that is 
supported by a localized version of Sun StorageTek EBS software 
automatically recognizes the font for the associated localized 
language. If the required font is loaded in the operating system, an 
appropriate language font can then be selected. 
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This chapter includes the following sections:
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Introduction
When updating to release 7.4 from Sun StorageTek EBS release 7.3 or 
earlier there is no way to revert to a previous release of the Sun 
StorageTek EBS software. It is a one-way conversion as the client file 
indexes are automatically reorganized into new directory structures. 
However, upgrades from Sun StorageTek EBS release 7.3.x can be 
downgraded back to the same release.

The Sun StorageTek EBS software does not support direct upgrade, 
which means the previous installed version must be removed before 
the new version can be installed. 

Java Web Start jnlp file caching issue after updating the  Management Console

After the  Management Console (NMC) is updated or a client locale is 
changed, the gconsole.jnlp file will be different than the original 
gconsole.jnlp file in the Java Web Start cache. NMC will fail to 
launch.

Workaround
Remove the Management Console Application and Language Pack 
from the Java Application Cache Viewer:

1. Select Java Web Start from the Programs menu.

2. Run the Java Application Cache Viewer.

3. Select Management Console Application and Language Pack.

4. Click Remove Selected Application.

Updating the Sun StorageTek EBS Software
This section explains how to complete the update process and 
convert the indexes:

◆ “Task 1: Prepare to update the software” on page 30

◆ “Task 2: Update the Sun StorageTek EBS software” on page 31

Task 1: Prepare to update the software
To prepare to update the Sun StorageTek EBS software:
Sun StorageTek Enterprise Backup Software Release 7.4 Installation Guide



Updating from a Previous Release
1. Determine whether all criteria to complete the index conversion is 
met. 

2. Make notes of the previous database location and port numbers 
used before removing the previous installation.

3. Back up all client file indexes and generate a bootstrap for the 
server.

If no current bootstrap exists, nor a backup of all client file 
indexes, perform scheduled backups on all clients before 
updating to the next Sun StorageTek EBS release. 

For example, to save the bootstrap information, type this 
command: 

savegrp -O group

Note: Ensure that all clients are included in the groups to be 
backed up.

4. Record the latest bootstrap save set ID and its associated volume 
label. 

To obtain this information, type this command:

mminfo -B

5. If the Sun StorageTek EBS software is not currently installed in 
the default location, record the location of the client file indexes.

Task 2: Update the Sun StorageTek EBS software

Note: A Sun StorageTek EBS storage node release 7.4 is not compatible with a 
Sun StorageTek EBS server earlier than release 7.4. Update the Sun 
StorageTek EBS servers to version 7.4 before updating a storage node.

To update the software on the Sun StorageTek EBS client, storage 
node, and server:

1. Ensure that all Sun StorageTek EBSscheduled backups have been 
stopped before starting the upgrades.

2. Keep a copy of the current configuration.

3. Type this command to shut down the Sun StorageTek EBS 
software:

nsr_shutdown
Updating the Sun StorageTek EBS Software 31



32

Updating from a Previous Release
4. Remove the earlier Sun StorageTek EBS release, but do not remove 
the client file indexes, the resource files, and the media database. 

5. Install the new release of the Sun StorageTek EBS software. 

Note: Do not start the Sun StorageTek EBS daemons. If client computers 
have a previous release of the Sun StorageTek EBS ClientPak for Linux 
installed, update those clients to the latest Sun StorageTek EBS release to 
fully exercise all the features in the software. When the installation 
identifies an existing Sun StorageTek EBS client package for Linux, it 
prompts for permission to update the client. The update process removes 
the existing Sun StorageTek EBS client and man pages and it installs the 
new version of the Sun StorageTek EBS client software.

6. Apply any required Sun StorageTek EBS software patches.

7. Restart the software by running the Sun StorageTek EBS startup 
script:

/etc/init.d/networker start

8. At the command prompt, enter the following command:

nsrck –L 2

9. Enable and register the Sun StorageTek EBS software. “Licensing 
and Enabling the Software” on page 95 provides instructions.
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Updating Sun StorageTek EBS clients by using the software 
distribution feature

Use the software distribution feature to remotely distribute and 
update the Sun StorageTek EBS software from a centralized Sun 
StorageTek EBS server to one or more Sun StorageTek EBS clients.

You can update these Sun StorageTek EBS software packages on 
computers that have the Sun StorageTek EBS release 7.3 or later client 
software already installed:

◆ Client

◆ Storage node

◆ Man pages

◆ NMO, NMSQL and NMExch NetWorker Application Modules

Note: The software distribution feature is not supported on HP Tru64 UNIX, 
IRIX, Mac OS X, NetWare, Open VMS platforms, and cluster environments.

The software distribution feature can be used to:

◆ Manage the software repository.

◆ Inventory Sun StorageTek EBS software installed on Sun 
StorageTek EBS clients.

◆ Update Sun StorageTek EBS software packages on existing Sun 
StorageTek EBS clients.

◆ Monitor software distribution inventory and upgrade operations 
(only available from the Software Administration Wizard).

Software distribution can be performed on the Sun StorageTek EBS 
client software using either the Software Administration Wizard or 
the nsrpush command. The following sections provide instructions 
on how to perform these operations.

Software requirements
The following software and administrative privileges are required:

◆ Sun StorageTek EBS server release 7.4 software is installed on the 
Sun StorageTek EBS server.
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◆ Sun StorageTek EBS client package release 7.3 or later software 
has been installed on the Sun StorageTek EBS client computer 
involved in the update operation.

◆ Administrative privileges on the Sun StorageTek EBS Console 
server.

◆ Administrator privileges on the Sun StorageTek EBS server or 
Software Administration server.

Repository operations using the Software Administration Wizard
To start the Software Administration Wizard:

1. Start the Sun StorageTek EBS Management Console software.

2. Launch the Administration window and click Configuration.

3. From the Configuration menu, select Software Administration 
Wizard.

The Software Administration Wizard launches.

Follow the prompts to manage the sotware repository (add or remove 
install packages), inventory, update, or monitor Sun StorageTek EBS 
client update operations.

Manage the software repository
The software repository is a centralized database that contains the 
Sun StorageTek EBS software packages that can be pushed to Sun 
StorageTek EBS clients from the Sun StorageTek EBS server. Sun 
StorageTek EBS software packages can be added to, or removed from 
the software repository.

When you add products to the repository, the product can be added 
in one of the following ways:

◆ On the same platform as the server (for example, a Windows 
product to a Windows server, or a UNIX product to a UNIX 
server)

◆ As a cross-platform product (for example, a UNIX product to a 
Windows server)

Adding same platform
products to the

repository

To add products to the repository that are on the same platform as the 
server:

1. Prepare the source of the product:
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• If using a software distribution disk, insert the disk. If using 
UNIX, it may also be necessary to mount the disk.

• If using a downloaded installation package, unzip the package 
(gunzip for UNIX). If using UNIX, also untar it.

2. Launch the Software Administration Wizard and click Next to 
navigate to the Software Repository Operations page.

3. Select Add or remove products from my software repository, 
then click Next.

Note: When products are added to the repository for the first time, you 
must confirm the default repository location (for example, <NetWorker 
Install Dir>/repository, where <NetWorker Install Dir> is the directory 
location of the installed software), or specify another location for the 
repository.

Also, when you specify a repository location, ensure that this location 
has enough available space to hold all of the products that will be in the 
repository at any time.

4. Navigate through the Wizard to select the platform type and 
enter the path or directory location on the server of the product 
source (the source that contains the installation files and the 
metafile for the product).

Note: The product source could also be a directory containing multiple 
subdirectories with products and metafiles.

5. Select the products to be added to the repository, then click Next.

Adding cross-platform
products to the

repository

To add cross-platform products to the repository (for example, a 
UNIX product to a Windows server):

1. Prepare the source of the product:

• If using a software distribution disk, insert the disk. If using 
UNIX, it may also be necessary to mount the disk.

• If using a downloaded installation package:

a. Copy the installation package to the Sun StorageTek EBS 
server (the server where the products will be added to the 
repository) and to the client where the product will be 
added from.
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b. Extract (unzip) the contents of the package to local 
directories on both the server and the client. If using UNIX, 
gunzip, then untar to separate subdirectories.

2. Launch the Software Administration Wizard and click Next to 
navigate to the Software Repository Operations page.

3. Select Add or remove products from my software repository, 
then click Next.

4. Navigate through the Wizard to select the platform type and 
enter the path or directory location on the server of the product 
source (the source that contains the installation files and the 
metafiles for the products).

Note: The product source could also be a directory containing multiple 
subdirectories with products and metafiles.

5. Select the products to be added to the repository and click Next.

The last page of the Wizard prompts you for the cross-platform 
client host name and client Media Kit Location (the location of the 
installation files).

6. If using a CD or DVD as the source, move the software 
distribution disk to the client machine, and mount the disk if 
necessary.

Once the local machine is scanned for metafiles, the disk must be 
on the client to add the product to the repository.

7. Specify the client host name and the location of the media kit on 
the client, then click Next.

IMPORTANT!
Ensure the cross-platform path entered here is at the same level 
of the directory structure that you specified for the path of the 
product source on the server. For example, if the product source 
containing the metafiles is located at /tmp/prod/nw74_solaris64 
on UNIX, and at C:\temp\prod\nw74_solaris64 on Windows, 
enter these paths when prompted.

If the product source is a directory containing multiple 
products (and their associated metafiles) in subdirectories, 
specify the directory path for the Media Kit Location, not the 
subdirectory path.  For example, if using a product distribution 
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disk mounted to /cdrom0 on UNIX and D:\ on Windows, and 
the disk contains subdirectories for solaris_64 and win_ia64, 
type /cdrom0 or D:\ when prompted for the media kit location. 
You will then be prompted to choose one or more products to 
add, based on the subdirectories found in the media kit 
location.  After doing so, type the hostname of the client where 
the product files need to be added, and then the pathname (for 
example, /cdrom0) for the media kit location on the 
cross-platform client. Do not specify the path name with the 
subdirectory (for example, D:\solaris_64), or an error will 
occur.

Inventory currently installed products
Before upgrading Sun StorageTek EBS clients using the Software 
Distribution feature, it is necessary to inventory the clients to 
determine their currently installed Sun StorageTek EBS software. To 
inventory the clients:

1. Launch the Software Administration Wizard and click Next to 
navigate to the Software Repository Operations page.

2. Select Discover the currently installed software products on my 
Sun StorageTek EBS clients, then click Next. 

A list of the clients configured on the Sun StorageTek EBS server 
appears.

3. Select some or all of the clients (use the Ctrl or Shift key when 
selecting multiple clients), then click Next.

4. Select Yes and click Next to monitor the inventory operation, or 
select No to return to the main window of the Software 
Administration Wizard.

Updating client software packages
You can update Sun StorageTek EBS software packages on Sun 
StorageTek EBS clients for one client, or for many Sun StorageTek EBS 
clients at the same time. The Software Administration Wizard 
provides two ways to perform client updates:

◆ By client

◆ By product and version

Updating by client To update the client software packages by client:
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1. Ensure that all Sun StorageTek EBS scheduled backups have been 
stopped before starting any upgrades.  

2. Inventory the clients to be updated (refer to the section 

3. Launch the Software Administration Wizard and click Next to 
navigate to the Software Repository Operations page.

4. Select Upgrade the software on my Sun StorageTek EBS clients 
and click Next. 

5. Select the option By Client, will upgrade on the clients that you 
choose and click Next.

A list of clients available clients appears.

6. Select the appropriate clients (use the Ctrl or Shift key to make 
multiple selections), then click Next.

A list of clients and products appears, showing one 
client/product per line.

7. Select one or more of the client/product combinations to 
upgrade, and click Next.  The Monitor Activity window appears.

Updating by product
and version

To update the client software packages by product and version:

1. Ensure that all Sun StorageTek EBS scheduled backups have been 
stopped before starting any upgrades.  

2. Inventory the clients to be updated (refer to the section 

3. Launch the Software Administration Wizard and click Next to 
navigate to the Software Repository Operations page.

4. Select Upgrade the software on my Sun StorageTek EBS clients 
and click Next. 

5. Select the option By Product and Version, will upgrade all 
clients to a new software version and click Next.

6. Select one or more products to update clients to (use the Ctrl or 
Shift key to make multiple selections), then click Next.

A list of clients and products appears, showing one 
client/product per line.

7. Select one or more of the client/product combinations to update, 
then click Next.  The Monitor Activity window appears.
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Monitoring the inventory and update activity of the software
You can monitor the progress of the Sun StorageTek EBS client 
operations and restart those that have failed from the Console server.  
The Monitor Activity window automatically appears after starting 
update operations from the Software Administration Wizard, and can 
be shown after initiating an inventory operation.  The monitor 
operation can also be started manually at any time.

1. Launch the Software Administration Wizard and click Next to 
navigate to the Software Repository Operations page.

2. Select the option Monitor current upgrade and inventory 
activities.   The Monitor Activity window appears.

Repository operations using the nsrpush command
Repository operations can also be performed by using the nsrpush 
command from the command line.

Manage the software repository
To view the products available on provided media kits (for example, 
on software distribution disks or downloaded installation packages):

◆ For UNIX products, run: 

nsrpush -L -U -m media kit location

◆ For Windows products, run:

nsrpush -L -W -m media kit location

Adding same platform
products to the

repository

To add same platforms products to the repository, run the following 
commands:

◆ On UNIX:

nsrpush -a -p Product Name -v version -P platform -U 
-m media kit location

◆ On Windows:

nsrpush -a -p Product Name -v versions -P platform -W 
-m media kit location

Note: You can only add one product at a time to the repository using this 
method.
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Adding cross-platform
products to the

repository

To add cross-platform products to the repository:

◆ On UNIX, run the following:

nsrpush -a -p <Product Name> -v <version> -P 
<platform> -W -m <media kit location> -c 
<cross-platform client> -C <cross-platform media kit 
location>

For example, to add a 64-bit Solaris product to a UNIX server 
with the media kit located in /tmp/prod, and at 
D:\\temp\downloads on the cross-platform client named 
"unixhost", run:

nsrpush -a -p NetWorker -v 7.4 -P solaris_64 -U -m 
/tmp/prod -c "unixhost" -C "D:\\temp\downloads"

◆ On Windows, run the following:

nsrpush -a -p <Product Name> -v <versions> -P 
<platform> -U -m <media kit location> -c 
<cross-platform client> -C <cross-platform media kit 
location>

For example, to add a 64-bit Solaris product to a Windows server 
with the media kit located at D:\temp\downloads on the server, 
and at /tmp/prod on the cross-platform client named 
"solaris_host":

nsrpush -a -p NetWorker -v 7.4 -P solaris_64 -U -m 
"D:\temp\downloads" -c "solaris_host" -C /tmp/prod

More details on the nsrpush command are provided on the nsrpush 
man page, or from nsrpush usage (running nsrpush with no 
options).

Inventory currently installed products
To inventory clients using the nsrpush command:

1. Enter the following command from the command line to view the 
list of clients to be inventoried:

nsrpush -i <client list>

where <client list> is a list of clients to be inventoried, separated 
by spaces.

2. Type the following command from the command line to 
inventory all configured clients:

nsrpush -i -all 
Sun StorageTek Enterprise Backup Software Release 7.4 Installation Guide



Updating from a Previous Release
Updating client software packages
You can update Sun StorageTek EBS software packages on existing 
Sun StorageTek EBS clients for one client, or for many clients, by 
using the nsrpush command. 

To update the client software packages:

1. Ensure that all Sun StorageTek EBS scheduled backups have been 
stopped before starting any upgrades.

2. Ensure that the clients to be upgraded have been inventoried.

3. Initiate the update by using the nsrpush command:

• To update all clients:

nsrpush -u -p <Product> -v <version> -all

• To update selected clients:

nsrpush -u -p <Product> -v <version> <Client list>

Note: When using the nsrpush command, multiple clients on different 
platform types can be updated at the same time if the product and version is 
the same. For example, if you wanted to update clients to the same version of 
a product (NetWorker release 7.4) for Windows and Linux, type nsrpush –u 
–p NetWorker –v 7.4 Windows Linux. However, if you want to update 
clients for different versions, only one product at a time can be updated.

More details on the nsrpush command are provided on the nsrpush 
man page, or from nsrpush usage (running nsrpush with no 
options).
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Installation roadmap
Use the following roadmap when installing the Sun StorageTek EBS 
software.

1. Review the requirements section and note the default directory 
location and space requirements for the software installation file. 
For information, see “Software Requirements” on page 17.

2. If there is an earlier release of Sun StorageTek EBS software 
installed, update the software. For information, see “Updating the 
Sun StorageTek EBS Software” on page 30.

3. Access the Sun StorageTek EBS software. For information, see 
“Accessing the software” on page 44.

4. Install the required Sun StorageTek EBS software. For 
information, see “Installing the software” on page 45

Note: You must install the Sun StorageTek EBS Console server software 
on one computer in your data zone to manage the Sun StorageTek EBS 
server. Only one installation of the Sun StorageTek EBS Console server is 
required to manage multiple Sun StorageTek EBS servers.

5. Test the Sun StorageTek EBS software. For information, see 
“Verifying the Installation” on page 89.

6. Enable and register all Sun StorageTek EBS products. For 
information, see “Licensing and Enabling the Software” on 
page 95.

Accessing the software
To access the Sun StorageTek EBS software from a local CD-ROM 
drive:

1. Log in as root on the computer where the Sun StorageTek EBS 
software is being installed.

2. Mount the CD-ROM drive.

3. Locate the appropriate directory on the CD-ROM.
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4. Ensure that the PATH environment variable for the user root on 
the Sun StorageTek EBS server and the user on each Sun 
StorageTek EBS client contain the directory where the Sun 
StorageTek EBS executables reside.

For example:

/usr/sbin

5. Install the software by using the instructions in “Installing the 
software” on page 45. 

Installing the software
Complete these tasks to install the Sun StorageTek EBS software.

Task 1: Install the Sun StorageTek EBS software
By default, the Sun StorageTek EBS software is installed in the /usr 
directory. However, the SUNWebsg package is installed in the /opt 
directory.

The Sun StorageTek EBS software can be installed in a default or 
nondefault location.

Installing to a default location
This section explains how to install the client, storage node, server, 
and Console server:

Client
To install the Sun StorageTek EBS software on the computer that is 
designated as the Sun StorageTek EBS client:

1. Type this command:

pkgadd -d /cdrom/cdrom0/solaris

Note: Do not press Enter for the default response All. Accepting the 
default installs the server.

2. Type the number of the option to install the client package 
(SUNWebsc). The client package temporarily requires 35 MB of 
free space on the client computer.

3. (Option) Type the number of the option to install a language 
support package. 
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4. Type the number of the option to install a language support 
package. For example:

• SUNWebfr (French)

• SUNWebja  (Japanese)

• SUNWebko (Korean)

• SUNWebzh  (Simplified Chinese)

5. (Optional) Type the a number of the option to install the man 
pages (SUNWebsm).

Note: If installing additional Sun StorageTek EBS software packages 
(storage node, server) to a Sun StorageTek EBS client that has processes 
running (for example, the nsrexecd process), an RPC error is reported. 
Before each software package is installed, the Sun StorageTek EBS 
software requires all Sun StorageTek EBS processes be shutdown. The 
RPC error is generated because the nsr_shutdown process attempts to 
stop Sun StorageTek EBS server processes when in fact no Sun 
StorageTek EBS server is running. This error message can be ignored and 
the installation process completes successfully. 

During the pkgadd process, ensure that no Sun StorageTek EBS 
processes are running. Do not start the Sun StorageTek EBS daemons 
until the final package is installed.

Storage node
To install the Sun StorageTek EBS software on the computer that is 
designated as the Sun StorageTek EBS storage node and for which 
you have purchased an enabler code:

1. Type the following command:

pkgadd -d /cdrom/cdrom0/solaris

2. Type the appropriate options to install the following packages. 

Software packages on the storage node must be installed in this 
order:

a. SUNWebsc (client software package)

b. SUNWebsn (storage node software package)

c. SUNWebsm (optional man pages)

3. Type the number of the option to install a language support 
package. For example:

• SUNWebfr (French)
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• SUNWebja  (Japanese)

• SUNWebko (Korean)

• SUNWebzh  (Simplified Chinese)

Server
To install the Sun StorageTek EBS software on the computer that is 
designated as the Sun StorageTek EBS server:

1. Keep a copy of the current configuration. The Sun StorageTek 
EBS software installation script modifies the /etc/rpc and 
/etc/syslog.conf files during the installation process.

Type these commands:

cp /etc/rpc /etc/rpc.old

cp /etc/syslog.conf /etc/syslog.conf.old

2. Type this command:

pkgadd -d /cdrom/cdrom0/solaris

3. Type the appropriate options to install the following packages. 

Software packages on the server must be installed in the 
following order:

a. SUNWebsc (client software package)

b. SUNWebsn (storage node software package) 

c. SUNWebss (server software package)

d. SUNWebsm (optional man pages)

4. Type the number of the option to install a language support 
package. For example:

• SUNWebfr (French)

• SUNWebja  (Japanese)

• SUNWebko (Korean)

• SUNWebzh  (Simplified Chinese)

Console server
To manage the Sun StorageTek EBS server, install the Sun StorageTek 
EBS Console and Sun StorageTek EBS client software on one machine 
in the datazone. The default install location for Console server 
package (SUNWebsg) is /opt. 
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The Console server installation relies on the existence of several other 
components. Ensure that all installation prerequisites are met. The 
section “Console” on page 21 provides details. 

To install Sun StorageTek EBS software on the computer that is 
designated as the Sun StorageTek EBS Console server:

1. Ensure that JRE version 1.4.2 or 1.5.0 is installed. This enables the 
command line reporting feature.

a. Change to the directory where the JRE is to be installed.

b. Run the following script:

pkgadd -d 
/cdrom/cdrom0/solaris/jre-1_5_0_11-solaris-sparc.sh

c. Accept the Java licensing agreement.

2. Start the Sun StorageTek EBS software installation:

pkgadd -d /cdrom/cdrom0/solaris

Note: Do not press Enter for the default response All. Accepting the 
default installs the server.

3. Type the appropriate option number to install the client package 
(SUNWebsc), if not already installed.

The client package temporarily requires 35 MB of free space on 
the client computer.

4. Type the appropriate option number to install the Console server 
package (SUNWebsg).

5. (Optional) Type the appropriate option number to install the man 
pages (SUNWebsm).

• SUNWebfr (French)

• SUNWebja  (Japanese)

• SUNWebko (Korean)

• SUNWebzh  (Simplified Chinese)

6. Follow the prompts to install the software. For example:

• For the web server port number, use the default port number 
(9000) or use a custom port number. Valid port numbers are 
between 1024 and 49151. 
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• For the Console server, use the default port number (9001) or 
use a custom port number. Valid port numbers are between 
1024 and 49151.

Note: Do not use port numbers that are already in use. Port 2638 is 
reserved by the Console server, as it uses Tabular Data Stream (TDS) 
protocol to communicate with the database. Port 9002 is the preferred 
port for the EMC Backup Advisor product.

7. Start the Sun StorageTek EBS Console daemons:

/etc/init.d/gst start

The Sun StorageTek EBS Console daemons include the following:

• gstd

• dbsrv9

• gsttclsh

8. If the Console server and the Sun StorageTek EBS server are 
installed on separate hosts, you must add the Console 
administrator to the administrator lists of the monitored Sun 
StorageTek EBS server. This enables the Console administrator to 
administer and monitor the target Sun StorageTek EBS server. 

On the Sun StorageTek EBS server:

a. Specify the process owner of the Console daemon process 
depending on which host contains the Console server: 

– If on a Microsoft Windows host, type:
nsraddadmin -u "user=SYSTEM, host=console_host"

– If on a AIX, HP-UX, Linux or Solaris only host, type:
nsraddadmin -u "user=root, host=console_host"

b. Specify the Console administrator user:

nsraddadmin -u "user=administrator, 
host=console_host"

Where console_host is the Console server hostname.

Installing to a nondefault location
By default, the following Sun StorageTek EBS software is installed in 
the /usr directory. If there is insufficient disk space on the /usr 
partition, the following Sun StorageTek EBS packages can be 
relocated to a specified directory on another partition:
Installing the software 49



50

Solaris Installation
◆ SUNWebsc  (client software package)

◆ SUNWebsn (storage node software package)

◆ SUNWebss  (server software package)

◆ SUNWebfr (French)

◆ SUNWebja  (Japanese)

◆ SUNWebko (Korean)

◆ SUNWebzh  (Simplified Chinese)

By default, the Sun StorageTek EBS Console server software is 
installed in the /opt directory. If there is insufficient disk space on the 
/opt partition, the Sun StorageTek EBS Console server package, 
SUNWebsg can be relocated to a specified directory on another 
partition.

The Sun StorageTek EBS man pages package (SUNWebsm) must 
always be installed in the default location. Table 1, “Solaris location 
and space requirements,” on page 21 provides a listing of the default 
locations and size requirements.

Note: Do not relocate any of the packages if Sun StorageTek EBS Module 
software is already installed on the computer.

To install the Sun StorageTek EBS packages to a nondefault location:

1. Copy the /var/sadm/install/admin/default file, as shown:

cp /var/sadm/install/admin/default /tmp/default.tmp

2. Edit the /var/sadm/install/admin/default file and change the 
value assigned to the basedir variable from default to ask, as 
shown:

basedir=ask

3. Create a directory and the bin/nsr and sbin/nsr subdirectories to 
install the Sun StorageTek EBS packages, for example:

mkdir -p /my_path/sbin/nsr

mkdir -p /my_path/bin/nsr

4. Modify the root PATH variable to include the bin and sbin 
subdirectories of the directory just created, for example:

/my_path/bin/nsr:/my_path/sbin/nsr

5. Type this command:
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pkgadd -d /cdrom/cdrom0/solaris

When this prompt appears in the script, type the same base 
directory for all the relocated packages:

Enter path to package base directory (default: /usr) 
[?,q] /my_path
Using /my_path as the package base directory.

6. When all the applicable packages are added and the prompt 
appears, press [q] to exit.

7. Copy the /tmp/default.tmp file to the following location. For 
example:

cp /tmp/default.tmp /var/sadm/install/admin/default

If pkgrm is used to remove the packages at a later date, specify the 
base directory.

Task 2: Change the Sun StorageTek EBS servers with access to a client
To limit the servers authorized to access a client, specify a list of 
trusted Sun StorageTek EBS servers for a client in the /nsr/res/servers 
file. After installing the client, storage node, and server software, use 
the following procedure to change the Sun StorageTek EBS servers 
that are authorized to access a client.

To change which Sun StorageTek EBS servers can access a client:

1. Type this command to shut down the Sun StorageTek EBS 
daemons:

nsr_shutdown

2. Edit or create the /nsr/res/servers file and add the set of Sun 
StorageTek EBS servers, one per line, that require access to the 
client. The first entry in this file becomes the default Sun 
StorageTek EBS server.

Note: If the /nsr/res/servers file is empty or does not exist, any Sun 
StorageTek EBS server is authorized to: 
- Access and back up the client.
- Perform a directed recovery to the client.

3. If necessary, remove the -s option from the nsrexecd command 
that is invoked by the boot-time startup file. Running nsrexecd 
with the -s option supersedes the /nsr/res/servers file:
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a. Check the Sun StorageTek EBS boot-time startup file to see 
whether nsrexecd is being run with the -s option. The 
boot-time startup file for the Solaris environment is 
/etc/init.d/networker.

b. If the -s option exists in the boot-time startup file, remove all 
occurrences of the following in the startup file:

-s server_name

Task 3: Start the Sun StorageTek EBS daemons
The Sun StorageTek EBS daemons must be started after the 
installation procedure. 

1. Start the Sun StorageTek EBS daemons by using this command: 

/etc/init.d/networker start

2. Verify that the Sun StorageTek EBS daemons are running:

ps -ef | grep nsr

3. If the output does not list nsrd and nsrexecd as current processes, 
run the following command to start the Sun StorageTek EBS 
daemons on the Sun StorageTek EBS server:

/etc/init.d/networker start

The Sun StorageTek EBS daemon nsrmmd is only present if one 
or more devices are enabled.

Note: You might need to install the UTF-8 converters available with your 
operating system.
Sun StorageTek Enterprise Backup Software Release 7.4 Installation Guide



Solaris Installation
Table 4 on page 53 lists the Sun StorageTek EBS daemons that should 
be running. 

Uninstalling the Sun StorageTek EBS software
Use the pkgrm command to uninstall individual Sun StorageTek EBS 
packages or all of the Sun StorageTek EBS packages simultaneously.

Software dependencies
The Sun StorageTek EBS software packages depend on each other. 
Uninstall them in this order:

1. SUNWebss

2. SUNWebsn

3. SUNWebsg

If the Console server software is installed (SUNWebsg), there is a 
dependency on the Sun StorageTek EBS client software and the 
Console server software must be uninstalled first.

4. SUNWebsc

5. SUNWebsm

6. SUNWebfr  (French language support package)

Table 4 Sun StorageTek EBS daemons

Sun StorageTek EBS 
installation packages Sun StorageTek EBS daemons

server nsrd, nsrexecd, nsrindexd, nsrmmdbd, nsrmmd, nsrjobd, nsrmmgd, 
nsrlcpd

Note: nsrlcpd is present only if the server has already been configured for a 
autochanger.

client nsrexecd

storage node nsrexecd, nsrmmd, nsrlcpd

Note: nsrlcpd is present only if the server has already been configured for a 
autochanger.
Uninstalling the Sun StorageTek EBS software 53



54

Solaris Installation
7. SUNWebja (Japanese language support package)

8. SUNWebko (Korean language support package)

9. SUNWebzh (Simplified Chinese language support package)

Note: The man pages and document files have no dependencies and can be 
uninstalled at any time.

Uninstalling the Sun StorageTek EBS software
To remove the Sun StorageTek EBS software packages:

1. Log in as root on the system where the software is being 
removed.

2. Type this command to shut down the Sun StorageTek EBS 
daemons:

nsr_shutdown

A list of Sun StorageTek EBS daemons that will be shut down 
appears, along with a prompt that asks whether to continue with 
the nsr_shutdown command.

3. Type this command to shut down the Console server:

/etc/init.d/gst stop

4. Remove the software:

• To remove all the packages, type this command:

pkgrm SUNWebss SUNWebsn SUNWebsg SUNWebsc SUNWebsm

Note: Do not choose the default option All to remove the Sun 
StorageTek EBS software packages. Choosing this option removes all 
the software packages (not just Sun StorageTek EBS software) that 
were installed on the computer by using the pkgadd utility.
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• To remove only select the Sun StorageTek EBS packages, see 
Table 5 on page 55.

Table 5 Sun StorageTek EBS packages to uninstall

To uninstall these Sun StorageTek EBS 
packages Type this command and package name

Server pkgrm SUNWebss

Storage node pkgrm SUNWebsn

Console server pkgrm SUNWebsg

Note: The SUNWebsg package must be uninstalled before the 
SUNWebsc package.

Client software pkgrm SUNWebsc

Man pages pkgrm SUNWebsm

Note: This removes the SUNWebsm package from the server, 
storage node, or client where the man pages are installed.

French language support pkgrmSUNWebfr 

Japanese language support pkgrmSUNWebja 

Korean language support pkgrmSUNWebko 

Simplified Chinese language support pkgrm SUNWebzh
Uninstalling the Sun StorageTek EBS software 55



56

Solaris Installation
Sun StorageTek Enterprise Backup Software Release 7.4 Installation Guide



5

This chapter includes these sections:
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Software installation roadmap
These tasks are a roadmap to follow when installing the Sun 
StorageTek EBS software:

1. Review “Installation requirements” on page 58 and note the 
default directory location.

2. Install the required Sun StorageTek EBS software by following 
one of these procedures:

• “Installing a Sun StorageTek EBS virtual server” on page 62

• “Installing a virtual Sun StorageTek EBS Console server” on 
page 78

• “Installing only the Sun StorageTek EBS client software in a 
cluster” on page 81

3. Enable and register all of the Sun StorageTek EBS products. 
Chapter 7, ”Licensing and Enabling the Software” provides 
detailed information.

Installation requirements
This section specifies the software and hardware required for 
installing and setting up the Sun StorageTek EBS server or client 
software within a Sun Cluster environment:

The EMC Information Protection Software Compatibility Guide 
provides the most up-to-date information about software and 
hardware requirements.

Software requirements
The following software must be installed on each node in the cluster:

◆ Solaris 8 or Solaris 9 operating environment is installed

◆ Sun Cluster version 3.0 or 3.1 is installed

◆ Volume Manager software (Solstice DiskSuite/Solaris Volume 
Manager)

Note: Highly available storage nodes are not supported.
Sun StorageTek Enterprise Backup Software Release 7.4 Installation Guide



Sun Cluster Version 3.0 or 3.1 Installation
Hardware requirements 
The following hardware requirements must be met:

◆ A multihosted disk is used as a mount point for the global file 
systems. These contain the shared /nsr area.

◆ A device with local affinity for the local bootstrap backup that is 
connected to all the nodes within the cluster.

Configuration options
Refer to the Sun StorageTek EBS Administration Guide for information 
about:

◆ Tape libraries with a Sun StorageTek EBS virtual server

◆ Remote physical storage node with a Sun StorageTek EBS virtual 
server

System information requirements
Table 6 on page 59 and Figure 1 on page 60 display the system 
information needed to install highly available Sun StorageTek EBS 
software within a Sun Cluster environment.

Table 6 System information

Information Required Example

Sun StorageTek EBS virtual hostname with an IP 
address in the same subnet as the cluster nodes

clus_vir1
192.168.1.10

Sun StorageTek EBS globally mounted configuration 
area

/global/nw

Sun StorageTek EBS cluster configuration script /usr/sbin/nsr/networker.cluster

File containing the host ID of all the cluster members /nsr/res/hostids
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Figure 1 Sample cluster configuration

Updating from a previous release of Sun StorageTek EBS 
software

To update from Sun StorageTek EBS releases 6.1.x and 7.x to Sun 
StorageTek EBS release 7.3 in a Sun Cluster 3.0 or 3.1 environment:

1. Collect this Sun StorageTek EBS software system information:

• The location of the Sun StorageTek EBS server global /nsr 
directory on the shared storage.

• The location of the Sun StorageTek EBS client local /nsr 
directories.

2. List and save the cluster resource group configuration:

scrgadm -pvv > scrgadm_pvv.out

Node 1 
clus_phys1

Node 2 
clus_phys2

Private Network

Local Disk Local Disk
clus_log1

If Node1fails,
clus_log1 fails
over to Node2

Public NetWork

Volume-managed Shared Disks

Terminal Concentrator

Administrative 
Workstation

Sun StorageTek EBS 
Logical Host (Virtual Server)
Sun StorageTek Enterprise Backup Software Release 7.4 Installation Guide



Sun Cluster Version 3.0 or 3.1 Installation
scconf -pvv > scconf_pvv.out

3. Use Sun StorageTek EBS software to back up the cluster. Ensure 
that you have a recent backup of the indexes and bootstrap by 
using the savegrp -O command.

4. Remove the Sun StorageTek EBS software cluster configuration 
files and uninstall the Sun StorageTek EBS software. Do not 
remove the global and local /nsr directories.

For instructions on uninstalling the Sun StorageTek EBS software, 
see “Uninstalling the Sun StorageTek EBS software” on page 86.

5. If required, upgrade the Sun Cluster software. For instructions, 
refer to the Sun Cluster documentation.

6. Install and configure the Sun StorageTek EBS 7.4 software.

Note: Do not relocate the Sun StorageTek EBS software. By default, the 
Sun StorageTek EBS is installed in the /usr directory.

7. Ensure that:

• You specify the same local /nsr and global /nsr directories.

• The Sun StorageTek EBS Client Type resource properties for 
Owned_paths and Clientname are the same as before the 
upgrade.

• The Sun StorageTek EBS Config_dir resource contains the 
same values as before the upgrade.

• The Network_resources_used property contains the same 
value that the Resource_dependencies property had before the 
upgrade.

Installing Sun StorageTek EBS software in a cluster
See these sections to install the Sun StorageTek EBS software in a Sun 
Cluster environment:

◆ “Installing a Sun StorageTek EBS virtual server” on page 62

◆ “Installing a virtual Sun StorageTek EBS Console server” on 
page 78

◆ “Installing only the Sun StorageTek EBS client software in a 
cluster” on page 81
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Note: Do not relocate the Sun StorageTek EBS software. By default, the Sun 
StorageTek EBS is installed in the /usr directory.

Installing a Sun StorageTek EBS virtual server
To install and configure the Sun StorageTek EBS software as a highly 
available service in a cluster, perform these tasks:

◆ “Task 1: Install the Sun StorageTek EBS software” on page 62

◆ “Task 2: Define the Sun StorageTek EBS server as highly 
available” on page 64

◆ “Task 3: Create an Instance of the Sun StorageTek EBS server 
resource group” on page 65

◆ “Task 4: (Optional) add a HAStoragePlus resource” on page 68

◆ “Task 5: Grant access to the highly available Sun StorageTek EBS 
server” on page 69

◆ “Task 6: Configure the Sun StorageTek EBS server” on page 71

◆ “Task 7: Configure clients under the Sun StorageTek EBS server” 
on page 71

◆ “Task 8: Create instances of the Sun StorageTek EBS Client 
resource type” on page 72

◆ “Task 9: Register licenses for the highly available Sun StorageTek 
EBS server” on page 75

◆ “Task 10: Authorize the software” on page 76

Task 1: Install the Sun StorageTek EBS software
The Sun StorageTek EBS software must be installed on all nodes in 
the cluster that are required to run the Sun StorageTek EBS resource 
group.

Note: Ensure that the following apply: 
- Solaris 8 or Solaris 9 operating environment and Sun Cluster 3.0 or 3.1 
software are already installed on all nodes in the cluster and that those nodes 
boot in cluster mode.
- PATH environment variable includes /usr/sbin and /usr/cluster/bin.
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To install the Sun StorageTek EBS software on nodes that will be 
running the Sun StorageTek EBS resource group:

1. Access the Sun StorageTek EBS software from the distribution 
media. The Sun StorageTek EBS Installation Guide provides 
installation instructions. 

2. Keep a copy of the current configuration. The Sun StorageTek 
EBS software installation script modifies the /etc/rpc and 
/etc/syslog.conf files during the installation process. 

Type these commands:

cp /etc/rpc /etc/rpc.old

cp /etc/syslog.conf /etc/syslog.conf.old

3. To install the software, type:

pkgadd -d .

4. Press Enter to install all of the packages on the server. Start the 
Sun StorageTek EBS daemons only after the last Sun StorageTek 
EBS package is installed.

Install selected software packages in this order: 

a. SUNWebsc (client software package)

b. SUNWebsn (storage node software package)

c. SUNWebss (server software package)

d. SUNWebsm (optional man pages)

5. Start the Sun StorageTek EBS daemons:

/etc/init.d/networker start

6. Type q to exit.

Note: Do not relocate the Sun StorageTek EBS software. By default, the 
Sun StorageTek EBS is installed in the /usr directory.
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Task 2: Define the Sun StorageTek EBS server as highly available
To define and configure the Sun StorageTek EBS server as highly 
available:

1. Log in as root.

2. Ensure that the /etc/hosts file on each cluster node contains the 
name of the logical host. The logical hostname can be published 
in the Domain Name System (DNS) or Network Information 
Services (NIS).

3. From each node in the cluster that will run the Sun StorageTek 
EBS server process:

a. Run the cluster configuration script networker.cluster located 
in /usr/sbin/nsr. 

This script defines the SUNWebss and the SUNWebsc 
resource types that the Sun StorageTek EBS software requires.

b. Type the information specified for each system prompt:

Enter directory where local Sun StorageTek EBS 
database is installed [/nsr]? 

– Type the location of the local Sun StorageTek EBS database 
directory provided during the installation procedure. For 
example: /space/nsr

Do you wish to configure for both Sun StorageTek 
EBS server and client?
Yes or No [Yes]? 

– Type Yes to configure the server software. This also installs 
the client software by default.

– Type No to configure only the client software.
Do you wish to add now the site-specific values 
for:
NSR_SHARED_DISK_DIR and NSR_SERVICE_ID 
Yes or No [Yes]?

– Type Yes to ensure compatibility with other cluster 
environments.

Enter the Logical Hostname to be used for Sun 
StorageTek EBS? 

– Type the published logical hostname to be used by the 
highly available Sun StorageTek EBS server. For example: 
clus_vir1
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In what path will this nsr directory be 
created/located? 

– Type the pathname of the globally mounted /nsr directory 
that will contain the configuration information for the 
highly available Sun StorageTek EBS server.

Note: For more information, see “System information requirements” 
on page 59.
To undo any changes to the configuration, run the networker.cluster 
-r script and then run the networker.cluster script again.

Task 3: Create an Instance of the Sun StorageTek EBS server resource group
A resource group must be created for the highly available Sun 
StorageTek EBS server. It must contain these resources:

◆ Logical hostname

◆ Globally mounted file system for the /nsr area

◆ LGTO.serv resource

◆ LGTO.clnt resource

◆ HAStoragePlus (optional)

To create an instance of the Sun StorageTek EBS Server resource 
group, perform these steps on one node in the cluster:

1. Create a resource group:

scrgadm -a -g networker

2. Add the logical host resource:

scrgadm -a -L -g networker -l clus_vir1

3. (Optional), create an instance of the SUNW.HAStoragePlus 
resource type:

a. Determine if the HAStoragePlus resource type is registered 
within the cluster:

scrgadm -p | egrep Type

b. If required, register the HAStoragePlus resource type within 
the cluster:

scrgadm -a -t SUNW.HAStoragePlus
Installing Sun StorageTek EBS software in a cluster 65



66

Sun Cluster Version 3.0 or 3.1 Installation
c. Create the SUNW.HAStoragePlus resource:

scrgadm -a -g networker -j hastorageplus -t 
SUNW.HAStoragePlus \
-x 
FilesystemMountPoints=/global/clus_vir1/nw,/global/
clus_vir1/
space
-x AffinityOn=True

Note: For more information on the SUNW.HAStoragePlus resource 
and the set up for locally mounted global systems, refer to the Sun 
Cluster 3.0 or 3.1 documentation.

4. Create an instance of the LGTO.clnt resource, type:

scrgadm -a -j client -t LGTO.clnt -g networker \
-x clientname=clus_vir1 \
-x 
owned_paths=/global/clus_vir1/nw,/global/clus_vir1/sp
ace

If the logical host resource name is different than the hostname it 
specifies, use this command to do the following:

a. Set the client name to the virtual hostname.

b. Set the optional network_resource property to the logical host 
resource name.

For example:

scrgadm -a -j client -t LGTO.clnt -g networker \
-x clientname=virtual_hostname -x 
network_resource=clus_vir1 \ 
-x 
owned_paths=/global/clus_vir1/nw,/global/clus_vir1/
space 

5. Create an instance of the LGTO.serv resource type:

scrgadm -a -j server -t LGTO.serv -g networker \
-y network_resources_used=clus_vir1 \
-y Resource_dependencies=hastorageplus \
-x config_dir=/global/clus_vir1/nw
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If the logical host resource name is different than the hostname it 
specifies, set the optional servername property to the virtual 
hostname: 

scrgadm -a -j server -t LGTO.serv -g networker \ 
-y network_resources_used=clus_vir1 \ 
-x servername=virtual_hostname \ 
-x config_dir=/global/clus_vir1/nw 

Note: If you are using a HAStoragePlus resource, set 
resource_dependencies property to the HAStoragePlus resource name. 

6. Start the Sun StorageTek EBS resource group:

scswitch -Z -g networker

Example 1 A highly available Sun StorageTek EBS server

In this example, a highly available Sun StorageTek EBS server uses 
the logical hostname backup_server. The highly available Sun 
StorageTek EBS server uses /global/networker (globally mounted file 
system) as its configuration directory.

1. Create a resource group with the name backups:

scrgadm -a -g backups

2. Add the logical hostname resource type to the resource group 
created in the previous step:

scrgadm -a -L -g backups -l backup_server

3. Create an instance of the LGTO.serv resource type with the name 
networker_server. This resource belongs to the resource group 
backups and has a dependency on the logical host created in the 
previous step.

Specify the configuration directory on the globally mounted file 
system /global/networker:

scrgadm -a -j networker_server -t LGTO.serv -g backups 
\ 
-y network_resources_used=backup_server \
-x config_dir=/global/networker
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4. The Sun StorageTek EBS logical host is also a client of the highly 
available Sun StorageTek EBS server. Create an instance of the 
LGTO.clnt resource type for the logical host backup_server within 
the resource group backups. The name of this resource is 
networker_client:

scrgadm -a -j networker_client -t LGTO.clnt -g backups 
\
-x clientname=backup_server -x 
owned_paths=/global/networker

5. Start the highly available service associated with the resource 
group backups.

scswitch -Z -g backups

Task 4: (Optional) add a HAStoragePlus resource
To add a SUNW.HAStoragePlus resource to an existing Sun 
StorageTek EBS server resource group: 

1. Determine whether the HAStoragePlus resource type is 
registered within the cluster:

scrgadm -p | egrep Type

2. If required, register the HAStoragePlus resource type within the 
cluster:

scrgadm -a -t SUNW.HAStoragePlus

3. Create the SUNW.HAStoragePlus resource:

scrgadm -a -g networker -j hastorageplus -t 
SUNW.HAStoragePlus -x 
FilesystemMountPoints=/global/clus_vir1/nw,/global/cl
us_vir1/space -x AffinityOn=True

4. Enable the HAStoragePlus resource:

scswitch -e -j hastorageplus

5. Set up a dependency for the Sun StorageTek EBS Server resource 
on the HAStoragePlus resource:

scrgadm -c -j server -y 
Resource_Dependencies=hastorageplus

6. Verify that the resource dependencies are correctly set:

scrgadm -pvv -j server | egrep strong 
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Task 5: Grant access to the highly available Sun StorageTek EBS server
Before a Sun StorageTek EBS server can back up a client, the client 
must grant the server access. Granting access is controlled by the 
servers file. For the node that is running the Sun StorageTek EBS 
Server resource group, this file is located in the globally mounted file 
system. Otherwise, this file is located on a local disk.

Note: If the /nsr/res/servers file is empty or does not exist, any Sun 
StorageTek EBS server is authorized to: 
- Access and back up the client.
- Perform a directed recovery to the client.

To grant access to the highly available Sun StorageTek EBS server:

1. On one node in the cluster:

a. Stop the Sun StorageTek EBS daemon by using the cluster 
management software, as follows:

scswitch -F -g NetWorker

b. Edit or create the servers file in the globally mounted /nsr 
area. For example, /global/nw/res/servers:

– Add the set of Sun StorageTek EBS servers, one per line, to 
be granted access to this client.

– Add an entry for the Sun StorageTek EBS logical hostname 
first. 

– Add entries for each physical host that can run the Sun 
StorageTek EBS resource group. 
For example:

clus_vir1

clus_phys1

clus_phys2

2. On each node in the cluster:

a. Shut down the Sun StorageTek EBS processes and verify that 
all Sun StorageTek EBS daemons have stopped:

nsr_shutdown
ps -ef | grep nsr
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b. Check the Sun StorageTek EBS boot-time startup file to see 
whether nsrexecd is being run with the -s option. 

If the -s option exists, remove all occurrences of -s servername in 
the file.

c. Edit or create the /nsr.NetWorker.local/res/servers file:

– Add the set of Sun StorageTek EBS servers, one per line, 
that require access to this client.

– Add an entry for the Sun StorageTek EBS logical hostname 
first. 

– Add entries for each physical host that can run the Sun 
StorageTek EBS resource group. 
For example:

clus_vir1

clus_phys1

clus_phys2

d. Restart the Sun StorageTek EBS processes:

/etc/init.d/networker start

3. On one node in the cluster, start the Sun StorageTek EBS daemon 
by using the cluster management software, as follows:

scswitch -Z -g NetWorker

4. If required, grant access to the Sun StorageTek EBS virtual server 
on clients outside of the cluster:

On each client that is outside of the cluster:

a. To shut down the Sun StorageTek EBS processes, type: 

nsr_shutdown

b. To verify that all Sun StorageTek EBS daemons have stopped, 
type:

ps -ef |grep nsr

c. Edit or create the /nsr/res/servers file:

– Add the set of Sun StorageTek EBS servers, one per line, 
that require access to this client.

– Add an entry for the Sun StorageTek EBS logical hostname 
first. 
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– Add entries for each physical host that can run the Sun 
StorageTek EBS resource group. 
For example:

clus_vir1

clus_phys1

clus_phys2

d. Type this command to restart the Sun StorageTek EBS 
daemons:

/etc/init.d/networker start

Task 6: Configure the Sun StorageTek EBS server
To configure the Sun StorageTek EBS server:

1. Log in as root on the cluster node that is currently running the 
Sun StorageTek EBS server resource group.

2. Start the Sun StorageTek EBS Console software.

3. From the Administration window, select Properties from the File 
menu.

a. For the Administrator attribute, add entries for any cluster 
nodes that are not already listed. For example:

root@hostname

b. Click OK.

Task 7: Configure clients under the Sun StorageTek EBS server
When the networker.cluster script runs, it creates a symbolic link 
named /nsr that points to a local disk. It also creates a second link 
named nsr.NetWorker.local that points to the local Sun StorageTek 
EBS directory. For example, if the local Sun StorageTek EBS directory 
was created in /var/nsr, each client member has these links:

◆ /nsr->/nsr.NetWorker.local

◆ /nsr.NetWorker.local->/var/nsr

To configure each client under the Sun StorageTek EBS server:

1. (Optional) Define save groups.

Note: In order for their save sets to restart after a virtual client or Sun 
StorageTek EBS server failover, save groups must have the Autorestart 
attribute enabled and the Manual Restart option disabled.
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2. Make each physical client within the cluster a client of the Sun 
StorageTek EBS server. For each physical client in the cluster:

a. Create a new client.

b. Type the name of the physical client for the Name attribute.

3. Make each virtual client within the cluster a client of the virtual 
Sun StorageTek EBS server. For each virtual client in the cluster:

a. Create a new Sun StorageTek EBS client.

b. For the Name attribute, type the name of the virtual client.

c. In the Remote Access attribute, add entries for each physical 
client within the cluster. For example:

root@clus_phys1

d. For the Group attribute, select a group.

4. Run a test probe to verify that the Client resource and the Group 
resource have been properly configured.

Type this command on the node on which the Sun StorageTek 
EBS server resides:

savegrp -pv -c client_name group_name

If the test probe does not display the correct scheduled backups 
and index, refer to the Sun StorageTek EBS Administration Guide.

Task 8: Create instances of the Sun StorageTek EBS Client resource type
An instance of the Sun StorageTek EBS Client resource type must be 
created for each virtual client that accesses data on globally mounted 
file systems. Virtual clients in Sun Cluster 3.0 and 3.1 are either 
logical hostnames or shared addresses. 

Note: All globally mounted file systems (except the /global/.devices/... file 
systems) must be owned by a resource group and defined in a Sun 
StorageTek EBS Client resource type. If the file systems are not properly 
configured, multiple copies will be backed up for each cluster node. 
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To back up the data for a virtual client: 

1. Create an instance of the Sun StorageTek EBS Client resource as 
part of an existing resource group that contains a logical host or 
shared addresses. For example:

scrgadm -a -j resource_name -g resource_group_name -t 
LGTO.clnt \ 

-x clientname=virtual_hostname -x 
owned_paths=pathname_1, pathname_2[,...]

The virtual_hostname variable is a hostname specified by a logical 
hostname or Shared Address resource. By default, the logical 
hostname or shared address resource name is the same as the first 
hostname in the list of hostnames the resource controls. 

If the logical hostname or shared address resource was explicitly 
named, set the optional network_resource property to the 
resource name:

scrgadm -a -j resource_name -g resource_group_name 
-t LGTO.clnt\

-x clientname=virtual_hostname 

-x network_resource=logicalhostname_ 
or_SharedAddress_resource_name \

-x owned_paths=pathname_1, pathname_2[,...]

These examples provide more information:

• “A highly available Informix database server” on page 74

• “A scalable Apache web server” on page 74

2. Run a test probe to verify that the Client and Group resources are 
properly configured.

Type this command on the node on which the Sun StorageTek 
EBS server resides:

savegrp -pv -c client_name savegroup_name

If the test probe does not display the scheduled backups and 
index, refer to the Sun StorageTek EBS Administration Guide.
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Example 2 A highly available Informix database server 

In this example, the Informix database server is configured to use the 
DNS registered hostname informix_lhrs. An existing failover resource 
group named informix_rg contains a:

◆ SUNW.informix resource named informix_res 

◆ SUNW.LogicalHostname resource named informix_lhrs

This SUNW.informix database server can access data on a global file 
system under /global/informix/config and /global/informix/db.

To add a Sun StorageTek EBS virtual client to the existing resource 
group informix_rg, type:

scrgadm -a -j informix_clntrs -g informix_rg -t LGTO.clnt 
\

-x clientname=informix_lhrs \
-x 

owned_paths=/global/informix/config,/global/informix/d
b

Example 3 A scalable Apache web server

In this example, an Apache web server is configured to use the DNS 
registered hostname apache_sars. An existing scalable resource group 
named apache_rg contains a:

◆ SUNW.apache resource named apache_res 

◆ SUNW.SharedAddress resource named apache_sars

This Apache web server accesses data on a global file system under 
/global/web/config and /global/web/data. 

To add a Sun StorageTek EBS virtual client to the existing resource 
group apache_rg, type:

scrgadm -a -j apache_clntrs -g apache_rg -t LGTO.clnt \
-x clientname=apache_sars \
-x owned_paths=/global/web/config,/global/web/data
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Task 9: Register licenses for the highly available Sun StorageTek EBS server
To register and license the highly available Sun StorageTek EBS 
server:

1. Order licenses for the type of Sun StorageTek EBS server and 
client configuration in use. 

Note: If you are Registering an Update from Solstice Backup 6.x to Sun 
StorEdge EBS 7.3, you will need a new Update for Sun StorEdge EBS 7.3 
enabler. Only customers with maintenance contracts will have 
automatically received Update for Sun StorEdge EBS 7.3 enablers. If you 
do not have a maintenance contract, order appropriate licenses for the 
highly available StorEdge Backup server and other desired features.

2. Log in to the system that is currently running the Sun StorageTek 
EBS resource group. 

3. Perform these operations to enter the purchased enabler codes:

a. If you have been evaluating the Sun StorageTek EBS highly 
available software and have now purchased the software:

– To upgrade from the base evaluation enabler to the 
purchased enabler, type:
nsrcap -v -u base_enabler_code

– Delete any remaining evaluation enablers:
nsradmin -s clus_vir1

This eliminates warning messages due to expiring evaluation 
enablers. 

b. For each enabler code, type:

nsrcap -v -c enabler_code

4. Ensure that the highly available Sun StorageTek EBS server is 
defined as a part of the cluster.

5. Run the following command, and capture the output, on each 
node that is currently running the Sun StorageTek EBS server 
resource group:

hostid

The numeric identifier of the current host prints.
Installing Sun StorageTek EBS software in a cluster 75



76

Sun Cluster Version 3.0 or 3.1 Installation
6. Log in to the system that is running the Sun StorageTek EBS 
virtual server and create the /nsr/res/hostids file. This file 
contains the host IDs of all the cluster nodes. 

Use this syntax:

hostid1:hostid2:hostid3:... 

For example:

12345678:87654321

7. Type the following commands to restart the server by taking the 
highly available Sun StorageTek EBS server offline and then 
putting it back online:

scswitch -F -g NetWorker

scswitch -Z -g NetWorker

8. On one node in the cluster:

a. Start the Sun StorageTek EBS Console. Use the logical 
hostname for the highly available Sun StorageTek EBS server.

b. From the Sun StorageTek EBS Administration window, note 
the host ID number for the appropriate cluster license.

c. Register the Sun StorageTek EBS software.

Note: Do not change the logical hostname for the highly available Sun 
StorageTek EBS server. If you change it after you update the software, you 
must permanently license and authorize the highly available Sun StorageTek 
EBS server.

Task 10: Authorize the software
To enter the permanent authorization code for Sun StorageTek EBS 
servers and clients: 

1. On one node in the cluster, start the Sun StorageTek EBS Console. 
Use the logical hostname for the highly available Sun StorageTek 
EBS server.

2. Complete the customer information and contact information 
fields:

a. Start the Sun StorageTek EBS Console software.

b. From the Administration window, click Configuration.

c. In the left pane, select the Sun StorageTek EBS server.
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d. From the File menu, select Properties. The Properties dialog 
box appears.

e. Select the Customer Information tab and complete your 
contact information.

f. Click Ok.

3. Review the registration information:

a. From the Administration window, click Configuration.

b. In the left pane, click Registration.

c. In the right pane, right-click the license to be authorized, then 
select Properties. The Properties dialog box appears.

d. Review the Auth Code attribute.

The registration window lists all enabled modules by name, serial 
number, composite host ID, the expiration date, and the enabler's 
authorization key 

• If an enabler is authorized, no expiration date is shown. 

• If an enabler is not authorized, an authorization key is not 
shown.

4. With the registration information and the composite host ID 
available, contact Sun. You can either:

• Call 1-800-usa4sun

• Send e-mail to license@sun.com.

To send e-mail, copy and paste the registration window contents 
(enabler codes, composite host ID, and expiration dates) along 
with your name, company name, address, phone number, e-mail 
address, and date of purchase into an e-mail message. Include a 
brief note stating that you are requesting authorization keys.

The authorizations keys are returned within two days by the 
same method you use to request them. 

If you do not enter an authorization key within 45 days of entering 
the purchased enabler code, you cannot back up data. However, 
you can recover data. 
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Installing a virtual Sun StorageTek EBS Console server
To install and configure the Sun StorageTek EBS Console server as a 
highly available service in a cluster, read and follow the procedures 
for these tasks:

◆ “Task 1: Install the Sun StorageTek EBS Management software in 
a cluster” on page 78

◆ “Task 2: Define the Sun StorageTek EBS Management server as 
highly available” on page 78

Task 1: Install the Sun StorageTek EBS Management software in a cluster
To install the Sun StorageTek EBS software on each node in the 
cluster:

1. Ensure that the most recent cluster patch for the operating system 
is installed.

2. Install the Sun StorageTek EBS Console server software 
(SUNWebsg) on each node in the cluster.

The Sun StorageTek EBS Installation Guide provides instructions.

Task 2: Define the Sun StorageTek EBS Management server as highly available
To define and configure Sun StorageTek EBS server as a highly 
available application:

1. From each node in the cluster:

a. Log in as root.

b. Ensure that the /etc/hosts file on each cluster node contains the 
name of the logical host. The logical hostname can be 
published in the Domain Name System (DNS) or Network 
Information Services (NIS).

2. From each node in the cluster that will run the Sun StorageTek 
EBS server process:

a. Run the cluster configuration script gst_ha.cluster located in 
/opt/SUNWebsg/bin/nsr. 

This script defines the GST_HA.serv resource type that the 
Sun StorageTek EBS Console server requires. 
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Note: When running the gst_ha.cluster script, ensure that you use 
the same values for logical hostname and for the global mounted 
path for all node in the cluster.

./gst_ha.cluster

NMC Console Server is in the process of being made a 
Highly Available application within Sun Cluster 
3.1.0,REV=2003.03.24.14.50.

To complete this task, the following are required.

A Logical host or virtual IP for the Console Server 
A globally mounted dir for the LGTOnmc database.

A GST_HA.serv resource type will be created via 
this process and will be needed to configure NMC as 
a Highly Available Application within Sun Cluster 
3.1.0,REV=2003.03.24.14.50.

Do you wish to continue? [Yes]?

Restarting syslog daemon...

Please enter Logical Hostname to be used by NMC 
server? hunt

Is the Logical Hostname entered correct (y/n)? y

The lgto_gstdb database should be on a globally 
mounted filesystem which can be accessible by the 
cluster nodes which will host the Highly Available 
NMC server.

Please enter the globally mounted shared directory 
for the lgto_gstdb database (/global/logicalhost)? 
/global/hunt/data1

Is the shared directory path entered for the 
lgto_gstdb database correct (y/n)? y

Moving /bigspace/lgto_gstdb local gstdb directory 
to globally mounted /global/hunt/data1/lgto_gstdb 
Resource type GST_HA.serv is not registered 
Defining GST_HA.serv resource type with RGM.

NMC has been successfully cluster-configured.

b. Ensure that the GST_HA.serv resource type was created. 

scrgadm -pv -t GST_HA.serv

Res Type name: GST_HA.serv
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GST_HA.serv) Res Type description: NMC Server for 
Sun Cluster

GST_HA.serv) Res Type base directory: 
/opt/LGTOnmc/bin

GST_HA.serv) Res Type single instance: False

GST_HA.serv) Res Type init nodes: All potential 
masters

(GST_HA.serv) Res Type failover: False

(GST_HA.serv) Res Type version: (GST_HA.serv) 

Res Type API version: 2

(GST_HA.serv) Res Type installed on nodes: <All>

(GST_HA.serv) Res Type packages: <NULL>

Note: To undo any changes to the configuration, run the 
gst_ha.cluster -r script and then run the gst_ha.cluster script again.

3. From one node in the cluster:

a. Create a resource group named "nmc":

scrgadm -a -g nmc

b. Create a logical hostname resource: For example:

scrgadm -a -L -g nmc -l logical_hostname

c. Create an nmc server resource instance. For example:

scrgadm -a -j nmc_server_name -t GST_HA.serv -g nmc 
-y network_resources_used=logical_hostname 
-x database_dir=database_dir

4. Perform these steps when the authorization keys arrive: 

a. On one node in the cluster, start the Sun StorageTek EBS 
Administrator program by using the logical hostname for the 
highly available Sun StorageTek EBS server:

nwadmin -s clus_vir1

b. From the Server menu, select Registration. 

Enter each authorization key into the Authorization Key text box for 
the corresponding enabler, and then click Apply. 
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Installing only the Sun StorageTek EBS client software in a cluster
In this configuration, the Sun StorageTek EBS server is running on a 
node that is not a member of the cluster.

To install a Sun StorageTek EBS cluster client, perform these tasks:

◆ “Task 1: Install the Sun StorageTek EBS software” on page 62

◆ “Task 2: Configure Sun StorageTek EBS client software as highly 
available” on page 82

◆ “Task 3: Create instances of the Client resource type” on page 83

◆ “Task 4: Define the list of trusted Sun StorageTek EBS servers” on 
page 84

◆ “Task 5: Configure clients under the Sun StorageTek EBS server” 
on page 85

Note: Ensure that the Sun StorageTek EBS client software is installed on each 
node in the cluster. Do not relocate the Sun StorageTek EBS software. By 
default, the Sun StorageTek EBS is installed in the /usr directory.

Task 1: Install the Sun StorageTek EBS cluster client software

Note: Ensure that the Solaris 8  operating environment and Sun Cluster 3.0 or 
3.1 software are already installed on all cluster nodes and that those nodes 
boot in cluster mode. Also, ensure that the PATH environment variable 
includes /usr/sbin and /usr/cluster/bin.

To install the Sun StorageTek EBS software on the computer that is 
designated as the Sun StorageTek EBS client:

1. Access the Sun StorageTek EBS software from the distribution 
media. The Sun StorageTek EBS Installation Guide provides 
installation instructions.

2. Type the pkgadd -d . command:

Note: Do not press the Enter key for the default response All. Accepting 
the default installs the server package.

3. Type the appropriate option number to install the client package .
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4. (Optional) Type the appropriate option number to install the man 
pages.

5. Type this command to start the Sun StorageTek EBS daemons:

/etc/init.d/networker start

6. When all the applicable packages have been added, and the 
prompt appears, type q to exit.

Task 2: Configure Sun StorageTek EBS client software as highly available
To define and configure a Sun StorageTek EBS client as highly 
available:

1. Log in as root on each node where the Sun StorageTek EBS 
software is being installed.

2. Ensure that the /etc/hosts file on each cluster node contains the 
name of the virtual host. The virtual hostname can be published 
in the DNS or NIS.

3. For each node in the cluster:

a. Run the cluster configuration script, 
/usr/sbin/nsr/networker.cluster. 

This script defines the LGTO.clnt resource types that the Sun 
StorageTek EBS software requires.

b. In response to the prompts, type the appropriate response::

Enter directory where local Sun StorageTek EBS 
database is installed [/nsr]? 

– Type the location of the local Sun StorageTek EBS database 
directory is provided during the installation procedure. 
For example: /space/nsr.

Do you wish to configure for both Sun StorageTek 
EBS server and client? Yes or No [Yes]? 

– Type No. This configures only the client software.

Note: Any changes to the configuration can be undone by running 
the networker.cluster -r option and then running the 
networker.cluster script again. 
For information, see “System information requirements” on 
page 59.
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Task 3: Create instances of the Client resource type
An instance of the Sun StorageTek EBS Client resource type must be 
created for each virtual client that accesses data on globally mounted 
file systems. Virtual clients in Sun Cluster 3.0 and 3.1 are either logical 
hostnames or shared addresses. 

Note: All globally mounted file systems (except the /global/.devices/... file 
systems) must be owned by a logical host and defined in a Sun StorageTek 
EBS Client resource type. If the file systems are not properly configured, 
multiple copies will be backed up for each cluster node.

To back up the data for a virtual client, from any node in the cluster, 
create an instance of the Sun StorageTek EBS Client resource as part 
of an existing resource group that contains a logical host or shared 
address. For example:

scrgadm -a -j resource_name -g resource_group_name -t 
LGTO.clnt \

-x clientname=virtual_hostname -x owned_paths=pathname_1, 
pathname_2[,...]

Example 4 A highly available Informix database server 

In this example, the Informix database server is configured to use the 
DNS registered hostname informix_lhrs. 

An existing failover resource group named informix_rg contains a:

◆ SUNW.informix resource named informix_res 

◆ SUNW.LogicalHostname resource named informix_lhrs

This SUNW.informix database server can access data on a global file 
system under /global/informix/config and /global/informix/db.

To add a Sun StorageTek EBS virtual client to the existing resource 
group informix_rg, type:

scrgadm -a -j informix_clntrs -g informix_rg -t LGTO.clnt
-x clientname=informix_lhrs 
-x owned_paths=/global/informix/config, /global/informix

/db
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Example 5 A scalable Apache web server

In this example, an Apache web server is configured to use the DNS 
registered hostname apache_sars. An existing scalable resource group 
named apache_rg contains a:

◆ SUNW.apache resource named apache_res 

◆ SUNW.SharedAddress resource named apache_sars

This Apache web server accesses data on a global file system under 
/global/web/config and /global/web/data. 

To add a Sun StorageTek EBS virtual client to the existing resource 
group apache_rg, type:

scrgadm -a -j apache_clntrs -g apache_rg -t LGTO.clnt \
-x clientname=apache_sars \
-x owned_paths=/global/web/config,/global/web/data

Task 4: Define the list of trusted Sun StorageTek EBS servers
Before a Sun StorageTek EBS server can back up a client, the client 
must grant the server access. Granting access is controlled by the 
servers file. For the node that is currently running the Sun StorageTek 
EBS Server resource group, this file is located in the globally mounted 
file system. Otherwise, this file is located on a local disk. 

Note: If the /nsr/res/servers file is empty or does not exist, any Sun 
StorageTek EBS server is authorized to: 
- Access and back up the client.
- Perform a directed recovery to the client.

To define the list of trusted Sun StorageTek EBS servers, perform 
these steps on each node in the cluster:

1. Shut down the Sun StorageTek EBS processes and verify that all 
Sun StorageTek EBS daemons have stopped:

nsr_shutdown
ps -ef |grep nsr

2. Edit or create the /nsr/res/servers file and add the set of Sun 
StorageTek EBS servers, one per line, that require access to this 
client.
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3. Check the Sun StorageTek EBS boot-time startup file to see 
whether nsrexecd is being run with the -s option. If the -s option 
exists, remove all occurrences of the following in the file: 

-s servername 

4. Restart the Sun StorageTek EBS daemons:

/etc/init.d/networker start

Task 5: Configure clients under the Sun StorageTek EBS server
To configure the Sun StorageTek EBS server:

1. Make each physical client within the cluster a client of the Sun 
StorageTek EBS server. For each physical client in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the physical client.

Note: If a physical client is backed up to a Sun StorageTek EBS server 
outside the cluster, the name of any virtual service that can run on the 
physical node must be added to the Remote Access list of the physical 
Client resource.

2. Make each virtual client within the cluster a client of the Sun 
StorageTek EBS server.

For each virtual client in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the Sun StorageTek 
EBS server.

c. For the Remote Access attribute, add entries for each physical 
client within the cluster. For example:

root@clus_phys1

d. For the Group attribute, select a group.

3. Schedule backups by using the Sun StorageTek EBS application. 

Note: The Sun StorageTek EBS server might reside outside of the cluster. 
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Uninstalling the Sun StorageTek EBS software
To uninstall the Sun StorageTek EBS software from a cluster 
environment: 

1. On one node in the cluster, disable and remove all instances of the 
LGTO.serv and LGTO.clnt resource types in the cluster. 

For information, refer to the scswitch(1m) and scrgadm(1m) man 
pages.

2. On each node in the cluster:

a. Log in as root on the computer that the software is being 
removed.

b. Undo all changes to the configuration by running the 
networker.cluster -r option.

c. To shut down the Sun StorageTek EBS daemons, type:

nsr_shutdown

Note: Remove the Sun StorageTek EBS software packages in this 
order:
- SUNWebss
- SUNWebsn
- SUNWebsg
-SUNWebsc

The man pages (SUNWebsm) and document files have no 
dependencies and can be removed at any time.

d. To remove all the packages, type:

pkgrm SUNWebss SUNWebsn SUNWebsg  SUNWebsc  
SUNWebsm

Configuring an external client to a virtual server
Use this procedure to configure and back up an external Sun 
StorageTek EBS client to a highly available Sun StorageTek EBS 
server. Before a Sun StorageTek EBS server can back up a client, the 
client must grant the server access. Granting access is controlled by 
the servers file. If the servers file does not exist, any Sun StorageTek 
EBS server can back up this client. If the servers file does exist, only 
the specific servers listed in the file can back up the client.
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On each Sun StorageTek EBS client that is outside of the cluster:

1. Shut down the Sun StorageTek EBS processes:

nsr_shutdown

2. Verify that all Sun StorageTek EBS daemons have stopped:

ps -ef |grep nsr

3. Edit or create the /nsr/res/servers file:

a. Add the set of Sun StorageTek EBS servers, one per line, that 
require access to this client.

b. Add an entry for the Sun StorageTek EBS logical hostname 
first. Then add entries for each physical host that can run the 
Sun StorageTek EBS resource group. For example:

– clus_vir1

– clus_phys1

– clus_phys2

Defining ownership of a raw partition for virtual clients
To back up the raw partitions of a Sun StorageTek EBS virtual client, 
ensure that the raw device path appears in the owned paths field of 
the LGTO.clnt resource. 

Example 6 A highly available web server

In this example, a highly available web server uses the shared 
address web_server. The web server services are placed under the 
control of the apache_rg resource group. The services access files that 
are kept in two separate globally mounted file systems: 
/global/web/config and /global/web/data. The web server also 
accesses the raw partition /dev/md/hunt/rdsk/d30.

To create the Sun StorageTek EBS Client resource named apache_nw, 
type: 

scrgadm -a -j apache_nw -g apache_rg -t LGTO.clnt
-x clientname=web_server \
-x owned_paths=/global/web/config,/global/web/data,

/dev/md/hunt/rdsk/d30

For information on backing up raw partitions, refer to the rawasm 
command as described in the uasm(1m) man page.
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Verifying the Installation
Introduction
This chapter provides information about testing and verifying the 
Sun StorageTek EBS software installation. To verify that the Sun 
StorageTek EBS software was installed properly, you must first 
connect to a Sun StorageTek EBS server, configure a device, and then 
test the software on the device.

Task 1: Start the Console for the first time
To run the Console, ensure that the Console server has been installed 
on a Solaris, Microsoft Windows or Linux host. You can not initiate a 
browser session from an Irix or HP Tru64 UNIX server. You can 
however, open a browser session with the Console from a Linux, 
Solaris, Microsoft Windows, HP-UX, or an AIX host.

These steps assume that the Sun StorageTek EBS software is installed 
and that all of the software and hardware requirements have been 
met on the computer that will access the Console. “Sun StorageTek 
EBS Management Console” on page 14 provides information about 
the Console.

To start the Console server software for the first time:

1. Verify that the console processes gstd, dbsrv9 and gsttclsh are 
running on the Sun StorageTek EBS Management Console 
server.

2. Start a web browser session.

3. Type the URL of the Console server:

http://server_name:http_service_port

where:

• server_name is the name of the computer where the Console 
server component was installed.

• http_service_port is the port for the embedded HTTP server. The 
HTTP port is specified during installation. The default HTTP 
port is 9000.

For example: http://houston:9000

4. From the Welcome page, click Start. 
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5. From the Security Warning screen, click Start to install and run 
Sun StorageTek EBS Console.

6. Type this command to start the Console server:

/etc/init.d/gst start

7. If JRE 1.5 was not already installed on the system, a prompt to 
install it appears. Follow the onscreen instructions to install JRE.

8. In the Sun StorageTek EBS Management Console Login dialog 
box, type the username and password.

Note: The default user is administrator and the default password for the 
administrator is “administrator”. For security purposes, this password 
should be changed during the first login session.

9. Click OK. The Console window and the Getting Started page 
appears.

How to start the Console after the first time
After the Console has been started the first time, start it later by using 
one of the following methods:

◆ Point the browser to the same URL as in “Task 1: Start the Console 
for the first time” on page 90.

◆ Double-click Sun StorageTek EBS Console in the Java Web Start 
Application Manager.

Task 2: Add a Sun StorageTek EBS server to the Sun StorageTek 
EBS Console server

To add and select a Sun StorageTek EBS server:

1. Start the Sun StorageTek EBS Console software.

2. From the Console window, click Enterprise.

3. From the left pane, select the Enterprise icon.

4. From the File menu, select New>Host. 

5. Type a hostname and alias for the Sun StorageTek EBS server. 

The Sun StorageTek EBS server appears in the right pane and left 
pane.
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6. From the left pane, select the Sun StorageTek EBS server.

7. From the right pane, select the Sun StorageTek EBS application.

8. From the Enterprise menu, select Launch Application. 

The Sun StorageTek EBS Administration window is launched.

If the server connection fails, refer to the server connectivity 
information in the Sun StorageTek Enterprise Backup Software 
Administration Guide to troubleshoot the problem.

Task 3: Configure a stand-alone device
Devices must be configured before testing the Sun StorageTek EBS 
software.

You can configure one of these devices:

◆ “Stand-alone tape device” on page 92

◆ “Stand-alone file or advanced file device” on page 93

◆ “Autochanger or silo” on page 93

The Sun StorageTek Enterprise Backup Software Administration 
Guide provides information about configuring a device.

Stand-alone tape device
To configure a stand-alone tape device:

1. In the server’s Sun StorageTek EBS Administration interface, click 
Devices.

2. From the left pane, select Devices.

3. From the left pane, select Storage Nodes.

4. Right-click the storage node for the device.

5. Select Scan for devices. 

The Scan for Devices window appears.

6. From the list, select the storage node to be scanned.

7. Click Start Scan after filling in the requested information.

The new device appears in the right pane.

8. From the right pane, select the new device.
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9. From the Devices menu, select Devices>Device 
Operations>Label. 

The Label window appears.

10. Verify the information in the Label window and click OK.  

Stand-alone file or advanced file device
To configure a stand-alone file or advanced files device:

1. In the server’s Sun StorageTek EBS Administration interface, click 
Devices.

2. From the left pane, select Devices.

3. From the File menu, select New. 

The Create Devices window appears.

4. For the Name attribute, type the device path.

5. For the Media type attribute, select file or adv_file.

6. Click OK. The new device appears in the right pane.

7. From the right pane, select the new device.

8. From the Devices menu, select Devices>Device 
Operations>Label.

9. Verify the information in the Label window and click OK.  

Autochanger or silo
To configure a new library resource (autochanger or silo) to a storage 
node: 

1. In the server’s Sun StorageTek EBS Administration interface, click 
Devices.

2. From the left pane, select Storage Nodes.

3. Right-click the storage node for the device.

4. Select Configure All Libraries.

5. Click Start Configuration after filling in the requested 
information.
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6. Click Finish on the Configuration window, when the 
configuration is complete.

Task 4: Test the Sun StorageTek EBS software installation
Test a Sun StorageTek EBS installation by performing an ad hoc 
(manual) backup of a file or folder. You can also use the Sun 
StorageTek EBS Client Configuration Wizard to configure a 
scheduled backup. The Sun StorageTek Enterprise Backup Software 
Administration Guide provides information about the wizard.

To test the Sun StorageTek EBS software on a stand-alone device, you 
can perform an adhoc backup from the command-prompt by using 
the save command. 

For example, to back up C:\myfile to the server jupiter, type:

save -s jupiter /tmp/myfile.txt

The UNIX man pages provides more information.
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How Sun StorageTek EBS software is licensed
Sun StorageTek EBS software and added features, such as modules, 
are installed in evaluation mode with all of the features enabled. The 
licensing of Sun StorageTek EBS software means entry of enabler and 
authorization codes on the server for the Sun StorageTek EBS 
environment. Without these codes, the software or added features 
will not run beyond the evaluation period.

Each installation of Sun StorageTek EBS server software must be 
licensed with a base enabler. This enabler “turns on” the software 
and allows you to use a particular bundle of features, such as a 
specified number of clients and devices. All licensing takes place on 
the server. The licenses are entered and stored on the server. The 
server enforces the licensing.

Base enablers come in different editions, which enable varying 
degrees of functionality. Add-on enablers allow a broader scope of 
features.

The steps in this chapter assume that the Sun StorageTek EBS 
software is installed and that all of the software and hardware 
requirements have been met on the computer that will access the 
Console.

The evaluation process
You can evaluate Sun StorageTek EBS software two ways:

◆ By evaluating a new installation of the software on a Sun 
StorageTek EBS server.

◆ By evaluating Sun StorageTek EBS features on an existing Sun 
StorageTek EBS installation.
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Evaluating a new installation
When you first install the Sun StorageTek EBS software, you can 
evaluate it with all the modules and features for 30 days free without 
entering any codes.

By the end of the evaluation period, you must purchase, enter, and 
authorize a base enabler to continue to use the Sun StorageTek EBS 
software to back up data. The base enabler is the license that enables 
the edition purchased. 

To continue to use some of the modules and features that were 
available with the evaluation software, you might need to purchase 
add-on enablers, depending on the edition of the base enabler.

Evaluating features on an existing installation
If you are evaluating one or more Sun StorageTek EBS Modules or 
features on an edition of Sun StorageTek EBS software that has 
already been installed and enabled, enter a temporary enabler for 
each module or feature. The temporary enabler is valid for 45 days. 

To obtain a temporary enabler code, contact Sun Sales or a Sun 
Reseller.

By the end of the evaluation period, you must purchase, install, and 
authorize the corresponding license enablers to continue to use 
modules or features you have evaluated.

◆ “The licensing process” on page 98 provides instructions.

◆ “Multiplatform licensing” on page 101 provides information on 
the different Sun StorageTek EBS features.

How to enter a temporary enabler code

CAUTION!
The temporary enabler code is valid on only one computer in a 
network. If you enter the same code on more than one computer in 
a network, a copy protection violation error occurs and the Sun 
StorageTek EBS server software is disabled on all Sun StorageTek 
EBS servers with duplicate enablers.
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To enter the temporary enabler code:

1. Start the Sun StorageTek EBS Management Console software.

2. Open the Administration window:

a. In the Console window, click Enterprise.

b. In the left pane, select a Sun StorageTek EBS server in the 
Enterprise list.

c. In the right pane, select the application.

d. From the Enterprise menu, click Launch Application. 

The Administration window is launched as a separate 
application.

3. From the Administration window, click Configuration.

4. In the left pane, select Registration.

5. From the File menu, select New.

6. In the Enabler Code attribute, type the enabler code.

7. In the Name attribute, type the name of the license.

8. (Optional) In the Comment attribute, type a description of the 
license.

9. Click OK.

The licensing process
To permanently use Sun StorageTek EBS software, you must 
purchase and enter a license enabler code, and then authorize it. This 
licensing process is the same for all editions of Sun StorageTek EBS 
software as well as for individual modules and features. 

The license enabler code that you purchase is valid for 45 days, as a 
registration period. During the registration period, you must obtain 
and enter a corresponding authorization code.

These sections explain how to enter and authorize the license enabler: 

◆ “Task 1: Enter the license enabler code” on page 99

◆ “Task 2: Obtain an authorization code” on page 100

◆ “Task 3: Enter the authorization code” on page 100
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Task 1: Enter the license enabler code

Note: To save time when entering multiple licenses, enter the base enabler 
last. Otherwise, once a base enabler is entered, devices that do not yet have 
licenses entered may be disabled. Those devices would have to be reenabled 
manually after their licenses are installed.

To enter the license enabler code:

1. Start the Sun StorageTek EBS Management Console software.

2. Open the Administration window:

a. In the Console window, click Enterprise.

b. In the left pane, click a Sun StorageTek EBS server in the 
Enterprise list.

c. In the right pane, click the application.

d. From the Enterprise menu, select Launch Application. 

The Administration window is launched as a separate 
application.

3. In the Administration window, click Configuration.

4. In the left pane, select Registrations.

5. From the File menu, select New. 

The Create Registration dialog box appears.

6. In the Enabler Code attribute, type the enabler code.

7. In the Name attribute, type the name of the license.

8. (Optional) In the Comment attribute, type a description of the 
license.

9. Click OK.

The new license is added and appears in the right pane. Repeat Step 1 
to Step 9 to add any additional enabler codes.

After you type a license enabler code, you have 45 days as a 
registration period to authorize the Sun StorageTek EBS software.
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Task 2: Obtain an authorization code

IMPORTANT!
If the software or feature is not authorized by the end of the 45-day 
registration period, the Sun StorageTek EBS backup function or 
feature is disabled. However, data that was backed up during the 
registration period can still be recovered from local devices.

Register Sun products and obtain authorization codes online by 
completing a registration form on the Sun website at www.sun.com. 
Web registration takes just a few minutes and is available 24 hours a 
day, 7 days a week.

An authorization code that permanently enables the Sun StorageTek 
EBS license will be sent by email.

If you have any questions regarding software updates, contact Sun 
Licensing.

Task 3: Enter the authorization code
To complete the licensing process, you must enter the unique 
authorization code on the Sun StorageTek EBS server within 45 days 
of entering the license enabler code.

If the authorization process is successful, the expiration date for the 
license displays “Authorized - No expiration date.” If the 
authorization is not verified in this way, contact the Sun Support.

To avoid an interruption in scheduled backups if you move the Sun 
StorageTek EBS software from one computer to another, or to change 
the network address of a computer after the software is installed, 
perform one of the following:

◆ Obtain a new authorization code. You need the host ID of the 
original server as well as the new server. The host ID appears in 
the server’s Registration window. 

◆ Install and configure the NetWorker License Manager software. 
“Managing licenses” on page 104 provides information on use of 
the NetWorker License Manager, and the latest NetWorker 
License Manager Installation and Administration Guide.
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To enter the authorization code:

1. Start the Sun StorageTek EBS Management Console software.

2. Open the Administration window:

a. In the Console window, click Enterprise.

b. In the left pane, select a Sun StorageTek EBS server in the 
Enterprise list.

c. In the right pane, click the application.

d. From the Enterprise menu, select Launch Application. 

The Administration window is launched as a separate 
application.

3. In the Administration window, click Configuration.

4. In the left pane, select Registration. 

5. In the right pane, select a license.

6. From the File menu, select Properties.

7. In the Auth Code attribute, type the authorization code for the 
product. The authorization code is the code assigned to the 
specified permanent enabler or update enabler code.

8. Click OK.

The license is now permanently enabled.

Multiplatform licensing
The client connections that come with a Sun StorageTek EBS server 
can be used for only that server platform. A  ClientPak® license 
allows the Sun StorageTek EBS server to back up clients of different 
platforms. For example:

◆ The client connections that accompany a NetWorker server for 
Microsoft Windows can be used for Windows client computers 
only.

◆ The client connections that accompany a Sun StorageTek EBS 
server for Solaris can be used for Solaris clients only.
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With a ClientPak for UNIX, other UNIX platforms can be enabled for 
use with a Sun StorageTek EBS server for Solaris. The ClientPak for 
UNIX supports all UNIX platforms. The ClientPak for UNIX is 
sufficient for all UNIX clients (backed up by a UNIX or Windows 
server).

Note: The Sun StorageTek EBS software treats Linux as a separate operating 
system. A ClientPak for Linux is necessary to back up Linux clients by either 
UNIX or Windows servers.

Example 7 Multiplatform licensing scenarios

A company was using a Linux server to back up Solaris, Linux, and 
Microsoft Windows clients. It needed two ClientPak licenses, one for 
Solaris and one for Microsoft Windows. The company added HP-UX 
and AIX clients, which required the addition of a ClientPak license 
for UNIX.

As the company grew and needed to add a server, it added a 
Windows 2000 server, which backed up the existing Windows clients 
and subsequent Windows 2000 clients without requiring a ClientPak. 
The company assigned the Sun StorageTek EBS server to a Solaris 
computer to back up the HP-UX, Solaris, and AIX clients by using a 
single ClientPak for UNIX.

Update enablers
To update existing Sun StorageTek EBS software to a major release, 
an update enabler is necessary. Update enablers are required for any 
major Sun StorageTek EBS software upgrade from release 4.0 and 
later, including the current Sun StorageTek EBS release. To use the 
NetWorker License Manager, the Sun StorageTek EBS server must be 
release 5.0 or later.

With a first-time purchase of Sun StorageTek EBS software, a 
one-year update agreement may be included. After a year, an update 
enabler may be acquired with a new update agreement purchase.
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Table 7 on page 103 lists the Sun StorageTek EBS releases that require 
update enablers.

Additional licenses
This section describes a few of the additional licenses required to 
operate some of the Sun StorageTek EBS features.

Client connection licenses
Every computer to be backed up in a Sun StorageTek EBS datazone 
requires a client connection license, even the Sun StorageTek EBS 
server. The client connection license may be one of the licenses that is 
supplied with the base enabler or purchased separately. A cluster 
client or NDMP data server requires a special type of client 
connection license.

Table 7 Update Enablers

Upgrade 
from to 5.0 to 5.5 to 5.5.x to 5.6 to 5.7 to 6.x to 7.0 to 7.1 to 7.2 to 7.3 to 7.4

Any release 
prior to 5.0 

yes yes yes yes yes yes yes yes yes yes yes

5.0 yes yes yes yes yes yes yes yes yes yes

5.5 yes yes (UNIX 
only)

yes
(NT only)

yes yes yes yes yes yes

5.5.x yes (UNIX 
only)

yes 
(NT only)

yes yes yes yes yes yes

5.6 NA* yes yes yes yes yes yes

5.7 yes yes yes yes yes yes

6.0 no yes yes yes yes yes

7.0 yes yes yes yes

7.1 yes yes yes

7.2 yes yes

7.3 yes yes

Note: * Release 5.6 is UNIX only, and release 5.7 is Microsoft Windows only.
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Storage nodes
Each storage node requires a storage node license, in addition to its 
client connection license. A dedicated storage node, which allows the 
storage node to back up only itself, is licensed separately.

NetWorker Application Modules 
NetWorker Application Modules are licensed on the basis of one 
enabler per database type host. For example, to back up the Oracle 
database on two hosts, two NetWorker Module for Oracle enablers 
are required, even if the two hosts are backed up by the same server. 
However, if multiple database instances are running on a Sun 
StorageTek EBS client host, only one NetWorker Module enabler is 
required for that one host.

Cluster clients
For each physical node in a cluster, you must purchase a Cluster 
Client Connection. The Sun StorageTek Enterprise Backup Software 
Administration Guide provides information on how to license 
computers in a cluster.

NDMP licensing
NDMP licensing requires one NDMP Client Connection per NAS 
array. 

Managing licenses
The NetWorker License Manager software provides centralized 
license management, which enables you to maintain all of an 
enterprise’s Sun StorageTek EBS licenses from a single computer. 
With the NetWorker License Manager, you can move Sun StorageTek 
EBS software from one computer to another, or change the IP address 
on an existing Sun StorageTek EBS server without having to 
reauthorize the software. The NetWorker License Manager can be 
installed as an option during the Sun StorageTek EBS software 
installation.
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To begin to implement the NetWorker License Manager:

1. Obtain bulk enabler codes. 

2. Install the NetWorker License Manager software.

3. Configure the NetWorker License Manager software.

4. Configure the Sun StorageTek EBS servers to access the 
NetWorker License Manager for their licenses.

The latest NetWorker License Manager Installation and 
Administration Guide provides more information on how to install 
and use the NetWorker License Manager.
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